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THANK YOU FOR CHOOSING PRINTMUSIC!
PrintMusic is a powerful integrated program for music transcrip-
tion, notation, playback, and publishing. Incorporating elements 
of a word processor, a graphics designer, a sequencer, and a 
page-layout program, PrintMusic has all the power you need to 
create beautiful looking sheet music and a quality Audio/MIDI 
performance. This program has the potential to help you produce 
more music—both printed and played—faster and better than 
ever before.

Take a moment to look over the contents of your PrintMusic 
package. It should include:

Installation & Tutorials Book

Quick Reference Guide

PrintMusic Installation Disc, along with your PrintMusic 
Serial Number

ABOUT THIS BOOK

In these pages, you’ll learn how to start putting PrintMusic to 
work right away. From installing the software, to entering music, 
to printing the score, and everything in between, we’ll cover all 
the basics you need to know to get up and running fast. The Win-
dows and Macintosh versions of PrintMusic are similar enough 
that we have incorporated instructions for both into this one 
book. You will notice, however, that there are two separate ver-
sions of the Installation instructions—one for Windows users 
and one for Macintosh users. These chapters provide platform-
specific installation and setup instructions. Beyond these initial 
chapters, the book applies to both platforms; any differences will 
be indicated by separate instructions for each platform, given in 
parentheses. (The majority of these differences will involve key-
strokes—e.g., ! for Windows, a or b for Macin-
tosh).
v



Before You Begin

Throughout this manual, you’ll 
find tip boxes; one is shown at 
right. These tip boxes contain 
helpful hints and tips that 
relate to the text where they’re 
found.

Learning PrintMusic won’t be difficult. Though the program 
offers hundreds of features and options, there’s absolutely noth-
ing wrong with ignoring the ones you’ll never use. Don’t have a 
MIDI instrument? Then skip those sections of the book. Don’t 
plan to use guitar fretboards? Then don’t bother learning that 
feature. You may need some of the other options another day—or 
never, depending on the kind of music you want to create; that’s 
perfectly OK. To help you get a jump start, we’ve divided Tutorial 
1 into separate entry methods. If you don’t have a MIDI key-
board, you can skip Tutorial 1c. After reading chapter 1a, if you 
feel comfortable using Simple Entry as your primary entry 
method, skip tutorial 1b.

Be sure to look at the Read Me file, which the PrintMusic 
Installer copies to your hard disk and installs in the PrintMusic 
folder. This document contains important information about 
PrintMusic that wasn’t available when this book went to press.

AUTHORIZATION/GETTING HELP

Your copy of PrintMusic must be authorized within 30 days of 
installation, after  which, printing and saving are disabled. To 
access the Authorization Wizard, click Authorize Now when you 
launch PrintMusic (or, from the Help Menu, choose Authorize 
PrintMusic). You have the option to authorize over the Internet, or 
by phone, fax, or mail. You will be asked to provide the serial 
number located on the interior of your PrintMusic 2008 CD/DVD 
case. If you are upgrading from an earlier version of PrintMusic, 
your serial number has not changed, and can be found in the 

Tip boxes look like this. In 
these boxes, you’ll find helpful 
tips and tricks along the way.
vi



Before You Begin

About box of your previous Finale version (under the Help or 
PrintMusic 2008 menu).

If you have a question about 
PrintMusic and can’t find the 
answer in this book, the USER 
MANUAL, or the QUICKSTART 
VIDEOS, additional help is available. Authorized owners may 
contact MakeMusic for customer support at www.finalemu-
sic.com/support. 

MakeMusic can also be reached by fax at (952) 937-9760, or by 
mail at 7615 Golden Triangle Drive, Suite M, Eden Prairie, MN 
55344-3848.

In addition to receiving customer support benefits, authorization 
means you can also be notified of free maintenance updates and 
discounts on future upgrades and new products.

Please visit www.finalemusic.com to download maintenance 
updates, learn about other Finale resources, and find more infor-
mation about the Finale family of notation products. Here you 
can also search our Knowledge Base for answers to frequently 
asked questions, and participate in Finale’s online community 
through interactive forums. 

Remember that extensive help is 
always at your fingertips: from the 
Help Menu, choose User Manual.
vii
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Installation for Windows

INSTALLING PRINTMUSIC

Macintosh users: skip to the next section, INSTALLATION FOR 
MACINTOSH.

Installing PrintMusic onto your hard disk is easy. Before you 
begin installing PrintMusic, make sure there’s enough room on 
your hard disk to hold the program and its associated files. For a 
full installation, you’ll need about one hundred megabytes 
(100,000K) of free space on your hard disk. You should also bear 
in mind that, like many other software programs, PrintMusic cre-
ates and makes use of “temporary files” during its normal opera-
tions, which it then deletes from your hard disk when you exit 
the program. We recommend having an additional ten megabytes 
(10,000K) of free disk space for these files.

Because some virus detection 
programs can prevent certain 
files from installing properly, we 
recommend you temporarily dis-
able anti-virus programs. Rest 
assured, your PrintMusic CD 
does not contain any viruses. If 
you are installing on Windows XP Professional or Vista, make 
sure you are logged in as the System Administrator and reboot 
after installation.

• Insert the Install disc into your CD/DVD drive.

• If the Setup Program doesn’t start, click the Start Menu 
and choose Run.

• Type d:\setup (where D represents the CD/DVD drive on 
your machine) and click OK. The PrintMusic Setup pro-
gram starts the installation process.

The Installer sets up a folder 
called “PrintMusic 2008” for 
the PrintMusic program and its 
associated files and folders. Do 
not alter this setup.
ix



Installation for Windows

• Follow the instructions 

on the screen until the 
installation is com-
plete. The PrintMusic 
Installer lets you select 
which files you want 
installed and where 
you want them placed 
on your hard disk. The 
Installer offers to create a folder called “PrintMusic”. We 
recommend that you install all of the PrintMusic files into 
this new folder. For the most part, you can press Enter to 
confirm each screen’s defaults.

• Remove the Installer disc from the drive and store it in a 
safe place! If anything happens to your hard disk, you can 
reinstall PrintMusic from your original disc.

When you open any older Finale family notation file (from the 
File Menu, choose Open, then navigate to your older file), 
PrintMusic takes a moment to convert it into the new format, 
then opens it as an “Untitled” file. If you save the file in Print-
Music using the same name as before, you will not be able to 
reopen that file using an earlier version of PrintMusic. It is 
suggested, therefore, that you save the file with a slightly dif-
ferent name (for instance, “My Score” could become “My 
Score 2”), unless you are absolutely sure that you won’t need 
to reopen it in an earlier version of PrintMusic.

PREPARING FOR PRINTING

Before you can print from PrintMusic, you must set up Windows 
to work with your printer. See your Microsoft Windows User 
Manual for details.

For information on printing in PrintMusic, see PRINTING in the 
User Manual or consult TUTORIAL 3 in this volume.

If upon trying to install, you get the 
error message: “Cannot find the 
file,” your CD/DVD drive may be 
assigned to a letter other than D. 
Look in “My Computer” to find out 
which letter is associated with your 
CD or DVD drive.
x



Installation for Windows

SETTING UP YOUR MIDI SYSTEM

If you are not using MIDI, skip this section. If you’re just getting 
started with MIDI, this section provides basic instructions for 
connecting your equipment.

MIDI stands for Musical Instrument Digital Interface. It’s the 
language spoken by computers and electronic musical instru-
ments. We’ll assume that you’re connecting a MIDI keyboard, 
although you can use any MIDI instrument. In this book, “MIDI 
keyboard” refers to whatever type of MIDI device you are using. 

We will assume that your computer is equipped with a sound 
card, which is designed to also act as a MIDI interface and has 
the appropriate driver software installed. If you are using a dedi-
cated MIDI interface, you will need to consult its documentation 
for instructions on setting up your MIDI system. At the very least, 
in addition to the sound card you will need the following equip-
ment for an operational MIDI system (not including your com-
puter):

A MIDI keyboard

Amplifier/speaker or headphones

A MIDI cable (the sound card accessory which connects to the 
card’s game/joystick port on one end, and has two MIDI 
cables on the other end)

The last item, a MIDI cable, is an optional accessory which may 
have been included when you purchased your sound card. If you 
do not have this accessory cable, contact a local music store or 
the manufacturer of your sound card.

• Install your sound card or USB interface and its drivers. See 
its documentation for instructions.

• Place the computer, keyboard, and MIDI interface where 
you want them. Go ahead and plug in any power cords, 
but don’t turn anything on yet.
xi
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• If you are using a sound card, plug the game/joystick port 

end of the MIDI cable into the game/joystick port of the 
sound card. If you are using a USB interface, connect it to 
your computer using a USB cable. Again, if you are using a 
USB interface, consult its documentation for specific 
instructions.

• Plug the MIDI cable marked MIDI OUT into the MIDI IN 
port on your MIDI keyboard, and the MIDI cable marked 
MIDI IN into the MIDI keyboard port marked MIDI OUT. 
The MIDI ports on a MIDI keyboard are usually on the 
back of the unit. The most common problem encountered 
by a new MIDI user is improperly connected cables. The 
trick is to think of the route the music data is taking. The 
notes you play will leave your MIDI keyboard from the 
port marked Out, and proceed to the computer through a 
cable or port marked In. Similarly, when the computer 
plays back your music, the notes leave the computer 
through the port or cable marked Out and enter the MIDI 
keyboard through the port marked In. So, although it may 
seem contrary to common sense, plug the In to the Out and 
vice versa. 

Your connections should resemble those in this figure:

• Turn on all your equipment. 

To Game/Joystick port
on Soundcard

Computer

KEYBOARD

MIDI In

MIDI Out

AMPLIFIER
&

SPEAKER
xii



Installation for Windows

If you discover that PrintMusic isn’t responding to your MIDI 
keyboard, check these connections again, and consult the 
manual that came with your sound card. 

STARTING AND AUTHORIZING PRINTMUSIC

• Windows Vista Users, right-click the PrintMusic icon and 
choose Run as Administrator. Windows XP users, double-
click on the PrintMusic icon. It will be on your desktop. 
When you launch PrintMusic for the first time, you will see 
the Authorize PrintMusic dialog box. This dialog box contin-
ues to appear each time you launch PrintMusic until the 
product is authorized. 

• Click Authorize Now! to start the PrintMusic Authoriza-
tion Wizard. Follow the simple instructions to authorize 
your copy of PrintMusic. Or, click Remind Me Later to 
authorize at a later time. You have 30 days to authorize 
your copy of PrintMusic. After 30 days, printing and sav-
ing are disabled until your copy of PrintMusic is autho-
rized. 

If you have Internet access (and are not running firewall, 
security, or virus software that would block information from 
being received back at your computer), simply select this 
option, and the rest is taken care of automatically.

Otherwise, select one of the other options for Manual via 
WebSite, FAX, or mail and a window will be displayed con-
taining a User Code. You may enter this code at www.finale-
music.com/register, print out this page and FAX or mail it to 
us, or call with your serial number and User Code. In any 
case, we will generate an Authorization Code that you manu-
ally type in to complete the process. Subsequently, our system 
automatically sends an e-mail confirmation of the informa-
tion. If you selected the internet option, but have a firewall 
that blocked the information from being received, then you 
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can manually type in the Authorization Code information pro-
vided.

Your copy of PrintMusic can be authorized on one operating 
system at a time, but with an Internet connection, authoriza-
tion can be moved from one computer to another at will. Sim-
ply choose Deauthorize PrintMusic from the Help Menu to 
open up a free authorization slot. Your copy of PrintMusic can 
now be authorized on a different computer (or another OS 
installed on the same computer if, for example, you are run-
ning both Mac and Windows on an Intel-based Mac). Also, 
deauthorize prior to making hardware changes to your com-
puter, such as replacing a hard drive. Doing so will ensure a 
slot is open to authorize after updating your hardware. When 
you deauthorize, printing and saving are disabled until autho-
rization has been restored.

PLEASE NOTE that the User/Authorization Codes are computer 
specific, and will only work on the given computer installation. 
Make sure that the Authorization Code is typed in using capital 
letters, and also verify that the correct serial number has been 
entered. If you have made a change to the computer (replaced the 
hard drive or motherboard, or installed a new operating system), 
and didn’t deauthorize prior to doing so, contact Customer Service 
directly by phone, FAX, or standard mail with your serial number 
and the location ID for the specific installation in question, and one 
of our representatives can clear the previous authorization from 
your account. If the software is not "reminding" you to authorize 
when you run the program, then the authorization has been suc-
cessfully completed.

Next, the MIDI Setup dialog box appears. Here, you can choose 
the devices you want to use for MIDI Input and playback. You’ll 
learn how to configure MIDI using this dialog box in the next 
section. 
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• Click OK. The Launch Window appears. From here, you 

can choose how you want to begin a new score, continue 
working on an existing project, or access reference materials. 
For example, choose Setup Wizard to begin a new custom 
document by specifying the title, staves, key signature, time 
signature, and other attributes for your new score. We’ll 
explain more about the Setup Wizard in chapter 1a.

THE MIDI SETUP DIALOG BOX

The first time you launch PrintMusic, the MIDI Setup dialog box 
will appear (subsequently it’s found in PrintMusic’s MIDI Menu).

This is where you instruct PrintMusic which MIDI drivers you’d 
like to use. PrintMusic begins by scanning your system and find-
ing the MIDI drivers that are already installed. On the left side of 
the dialog box, under MIDI In, the program will select the MIDI 
In Device that is present on your computer (for example, “Sound 
Blaster MIDI Input”). In the right-hand box, the program will 
select PrintMusic’s SoftSynth (software synthesizer) which is 
installed with PrintMusic. You can easily choose a different 
device to enter or play back your music. Any time you’d like to 
hear the music on your computer’s speakers (which are con-
nected to your sound card), you’d typically choose a driver with 
the term “Synth” or “Synthesizer” in it. If, on the other hand, 
you’d like PrintMusic to play back on an external MIDI device 
(which would require its own speaker and amplifier), choose a 
driver which has “MIDI Out” in its name.

You can leave SoftSynth selected for the MIDI output device to 
play back with your computer speakers using PrintMusic’s 
default General MIDI sounds. Or, choose from the available syn-
thesizers on your computer. The following diagram shows the 
MIDI Setup dialog box properly configured to play back through 
the computer’s speakers via a sound card.
xv



Installation for Windows
The diagram below shows the MIDI Setup dialog box properly 
configured to play back through an external MIDI device. Keep in 
mind that the specific driver names will change depending on 
what sound card or MIDI device you have.

For more information, consult the User Manual under MIDI 
SETUP DIALOG BOX. You’re all set to explore PrintMusic. Skip to 
the next section, HOW TO LEARN PRINTMUSIC.
xvi



Installation for Macintosh

INSTALLING PRINTMUSIC

Windows users: see the previous chapter INSTALLATION FOR 
WINDOWS or skip over this chapter.

Installing PrintMusic onto your hard disk is easy.

Before you begin installing 
PrintMusic, make sure 
there’s enough room on your 
hard disk to hold the pro-
gram and its associated 
files. For a full installation, 
you’ll need about one hundred megabytes (100,000K) of free 
space on your hard disk. You should also bear in mind that, like 
many other software programs, PrintMusic creates and makes 
use of “temporary files” during its normal operations, which it 
then deletes from your hard disk when you exit the program. We 
recommend having an additional ten megabytes (10,000K) of free 
disk space for these files.

• Insert the PrintMusic disc into your CD/DVD drive. Its icon 
appears on your desktop.

• Double-click the CD/DVD icon. The contents of the CD/DVD 
appear on your screen.

• Double-click the Installer icon. You are prompted to enter your 
computer administrator’s password. 

• Enter your password and click OK. In a moment, the PrintMusic 
Installer screen appears. 

Follow the instructions on the screen until the installation is com-
plete. The PrintMusic Installer lets you select which files you want 
installed and where you want them placed on your hard disk. The 
Installer offers to create a folder called “PrintMusic” We recommend 
that you install all of the PrintMusic files into this new folder. For 
the most part, you can press Return to confirm the defaults.When 
you open an older Finale family notation file (choose File, then 

The Installer sets up a folder called 
“PrintMusic” for the PrintMusic 
program and its associated files 
and folders. Do not alter this setup.
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Open and navigate to your older file), PrintMusic takes a moment 
to convert it into the new format, then opens it as an “Untitled” 
file. If you save the file in PrintMusic using the same name as 
before, you will not be able to reopen that file using an earlier 
version of PrintMusic. It is suggested, therefore, that you save the 
file with a slightly different name (for instance, “My Score” could 
become “My Score 2”), unless you are sure that you won’t need to 
reopen the file in an earlier version of PrintMusic.

PREPARING FOR PRINTING

These instructions cover the basic preparations for printing from 
PrintMusic or any program. If you can print successfully from 
other programs already, skip ahead to the next section. Before 
you print for the first time, you must tell the Macintosh where to 
send its printing information, especially if you have more than 
one printer.

TO SET UP YOUR PRINTER 

• Install OS X drivers for your printer. If the printer is compati-
ble with OS X, you’ll find these drivers on a CD included with 
your printer. You can also usually download the necessary 
drivers from the printer manufacturer’s web site. See the 
printer’s user manual for additional information.

• Navigate to the hard drive, and choose Applications, Utilities, 
and then Printer Setup Utility. The Print Center dialog box 
appears. 

• If your printer isn’t already listed, click the Add button. 

• In the new window, choose the appropriate zone from the 
pop-up menu. 

• Click your printer’s name and click Add. 

• Quit Print Center/Printer Setup Utility. 
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SETTING UP YOUR MIDI SYSTEM

MIDI stands for Musical Instrument Digital Interface. It’s the 
language spoken by computers and electronic musical 
instruments. We’ll assume that you’re connecting a MIDI 
keyboard, although you can use any MIDI instrument. In this 
manual, “MIDI keyboard” refers to whatever type of MIDI device 
you are using.

At the very least, you’ll need the following equipment for an 
operational MIDI system (not including your computer):

A MIDI keyboard

Amplifier/speaker or headphones

Two MIDI cables

A MIDI interface with appropriate USB cable 

The last item, a MIDI interface, is a box that translates the 
signals arriving from the MIDI keyboard into signals the 
computer understands, and vice versa. Interfaces can be very 
simple or very elaborate. The most basic ones require no external 
power and have ports (jacks) for a single MIDI keyboard; more 
expensive models have ports for multiple MIDI devices or other 
features. Most Macs have USB (Universal Serial Bus) ports, a 
standard that allows users to connect devices to their computers 
without needing to restart for the devices to become active. 

• Place the computer, keyboard, and MIDI interface where you 
want them. Go ahead and plug in any power cords, but don’t 
turn anything on yet.

• Plug one end of the MIDI interface cable into the interface (if 
applicable). Plug the other end into the USB or serial port on the 
back of your Macintosh.

• Plug one end of a MIDI cable into the MIDI keyboard port 
marked MIDI In. Plug the other end into the MIDI interface port 
marked MIDI Out. Plug the second MIDI cable into the interface 
xix
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port marked MIDI In and the MIDI keyboard port marked MIDI 
Out. The most common problem encountered by a new MIDI 
user is improperly connected cables. The trick is to think of the 
route the music data is taking. The notes you play will leave your 
MIDI keyboard from the port marked Out, and enter the 
interface through the port marked In, then on to the computer. 
Similarly, when the computer plays back your music, the notes 
go out from the computer to the interface, leave the interface 
through the port marked Out, and enter your MIDI keyboard 
through the port marked In. So, although it may seem contrary 
to common sense, plug the In to the Out and vice versa.

Your connections should resemble those in this figure:

• Turn on all your equipment. 

Your MIDI system is now configured. To name a MIDI device or 
configure additional settings, jump ahead to CONFIGURING 
MIDI IN OS X. If you do not wish to name a MIDI device or 
make additional settings, you can skip ahead to STARTING 
PRINTMUSIC.

CONFIGURING MIDI IN OS X

You can use helper utilities already available on your computer 
to configure your MIDI devices by following these steps.

MIDI In

MIDI Out

From serial
or USB port

MAC

INTERFACE KEYBOARD

MIDI In

MIDI Out

AMPLIFIER
&

SPEAKER
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Installation for Macintosh

• Navigate to your hard drive, and choose Application, Utilities, 

Audio MIDI Setup. The Audio MIDI Setup dialog box appears. 
Now, we’ll add new devices.

• Click the MIDI Devices tab. Audio MIDI Setup will search for 
MIDI hardware and software. After the search, your MIDI 
interface will appear.

• In the button bar, click Add Device to add a new device icon 
to the window below. If necessary, drag the new icon so it 
isn’t overlapping any others.

• Double-click the new device icon. The New External Device 
Properties dialog box appears.

• Enter a device name, then select or enter the manufacturer 
and model. If more options are required, click the More Prop-
erties arrow. 

• Click Apply and close the dialog box. Repeat the last four 
steps for any other devices. Now, we’ll connect new devices to 
the interface.
xxi
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• If you are using a controller for MIDI input, drag the outgoing 

arrow of the MIDI controller to the incoming arrow on the 
MIDI interface. 

• If you are using a sound module for playback, drag the incom-
ing arrow of the sound module to the outgoing arrow on the 
MIDI interface. 

• If you are using a device such as a MIDI keyboard for both 
input and playback, connect the outgoing arrow on the MIDI 
device to the incoming arrow on the MIDI interface, and then 
connect the incoming arrow of the MIDI device to the outgo-
ing arrow of the MIDI interface. Now, to ensure your devices 
are installed properly on your computer, we’ll test the MIDI 
setup.

• Click the “Test Setup” button on the upper right. The cursor 
changes into two eighth notes.

• Click the down arrow beneath a device’s icon . Your com-
puter sends a message to your MIDI device. You see the “Out” 
light illuminate on your MIDI interface and/or a sound played 
on the MIDI device.

• Click the Internal Speaker icon in the 
upper right corner of the finder and drag 
the slider near the top to ensure the vol-
ume is up (as shown here).

• Play a note on the external MIDI device. 
The external MIDI device sends a message 
to your computer. You see the “In” light on 
your MIDI interface illuminates and/or hear a beep from your 
computer’s internal speaker. 

• Quit Audio MIDI Setup. 

Now that you have set up MIDI with OS X, skip directly to 
STARTING PRINTMUSIC
xxii
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STARTING PRINTMUSIC

• Double-click on the “PrintMusic” icon on your Desktop. When 
you launch PrintMusic for the first time, you will see the Autho-
rize PrintMusic dialog box. This dialog box continues to appear 
each time you launch PrintMusic until the product is authorized. 

• Click Authorize Now! to start the PrintMusic Authorization 
Wizard. Follow the simple instructions to authorize your copy 
of PrintMusic. Or, click Remind Me Later to authorize at a 
later time. You have 30 days to authorize your copy of Print-
Music. After 30 days, printing and saving are disabled until 
your copy of PrintMusic is authorized. 

If you have Internet access (and are not running firewall, 
security, or virus software that would block information from 
being received back at your computer), simply select this 
option, and the rest is taken care of automatically.

Otherwise, select one of the other options for Manual via 
WebSite, FAX, or mail and a window will be displayed con-
taining a User Code. You may enter this code at www.finale-
music.com/register, print out this page and FAX or mail it to 
us, or call with your serial number and User Code. In any 
case, we will generate an Authorization Code that you manu-
ally type in to complete the process. Subsequently, our system 
automatically sends an e-mail confirmation of the informa-
tion. If you selected the internet option, but have a firewall 
that blocked the information from being received, then you 
can manually type in the Authorization Code information pro-
vided.

Your copy of PrintMusic can be authorized on one operating 
system at a time, but with an Internet connection, authoriza-
tion can be moved from one computer to another at will. Sim-
ply choose Deauthorize PrintMusic from the Help Menu to 
open up a free authorization slot. Your copy of PrintMusic can 
now be authorized on a different computer (or another OS 
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installed on the same computer if, for example, you are run-
ning both Mac and Windows on an Intel-based Mac). Also, 
deauthorize prior to making hardware changes to your com-
puter, such as replacing a hard drive. Doing so will ensure a 
slot is open to authorize after updating your hardware. When 
you deauthorize, printing and saving are disabled until autho-
rization has been restored.

PLEASE NOTE that the User/Authorization Codes are computer 
specific, and will only work on the given computer installation. 
Make sure that the Authorization Code is typed in using capital 
letters, and also verify that the correct serial number has been 
entered. If you have made a change to the computer (replaced the 
hard drive or motherboard, or installed a new operating system), 
and didn’t deauthorize prior to doing so, contact Customer Service 
directly by phone, FAX, or standard mail with your serial number 
and the location ID for the specific installation in question, and one 
of our representatives can clear the previous authorization from 
your account. If the software is not "reminding" you to authorize 
when you run the program, then the authorization has been suc-
cessfully completed.

• Click OK. The Launch Window appears. From here, you can 
choose how you want to begin a new score, continue working on 
an existing project, or access reference materials. For example, 
choose Setup Wizard to begin a new custom document by speci-
fying the title, staves, key signature, time signature, and other 
attributes. You’ll learn more about the Setup Wizard in chapter 
1a.

THE MIDI SETUP DIALOG BOX

The MIDI Setup dialog box is where you instruct PrintMusic 
which devices you’d like to use for MIDI functions. On the left 
side of the dialog box, you’ll choose the MIDI input device. On 
the right side, you’ll choose the desired output device. What you 
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choose here will determine on which device PrintMusic will play 
back your music. 

SETTING UP MIDI WITH OS X

• Start PrintMusic. 

• Navigate to the MIDI Menu and choose MIDI Setup. The MIDI 
Setup dialog box appears. 

• For the MIDI System, choose CoreMIDI. 

• Select the proper input and output devices from their respec-
tive menus. If only ports are listed, select the port on your 
interface to which your MIDI device is connected.

• Click OK. You’re all set to explore PrintMusic on your own.
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How to Learn PrintMusic

The remainder of this book contains step-by-step tutorials. It is 
best to take them in order, because each tutorial is more 
advanced than the one before it. 

For some of the tutorials, you’ll be 
working on prepared documents that 
are located in the Tutorials folder 
within the PrintMusic folder on your 
hard disk. In addition to these tutorials, high-quality sample 
scores are also included which offer a glimpse of Finale’s 
capabilities. PrintMusic itself contains powerful instructional 
tools: the Status or Message Bar along the edge of the application 
window, QuickStart Video Tips, Help, and the USER MANUAL. (At 
the end of each tutorial, you’ll find a short section called FOR 
MORE INFORMATION, which directs you to some “how-to’s” in 
the User Manual that relate to the topics you’ve just covered.)

• The Status Bar (Win) or Message Bar (Mac) shows you the 
name of each tool you click, and tells you what your next 
step should be. On Windows, it also displays a description of 
each menu or .

• Help provides context-sensitive help. Click the Help button 
or press F1 (Win) or Help (Mac) in any dialog box to show a 
discussion of the dialog box.

• QuickStart Video Tips are a series of videos that run on your 
computer and give you step-by-step instructions on the use of 
many of PrintMusic's tools and features. The Video Tips, 
which can be accessed through the Help Menu, are designed 
to enhance and support these tutorials. Feel free to use these 
Tips at any time to review any of the procedures outlined in 
this book.

• The User Manual is the most powerful and comprehensive of 
the instructional tools available to you. Here you will find 
detailed descriptions of each of PrintMusic's tools, dialog 
boxes, and other features, as well as step-by-step instruc-
tions on how to perform any task in PrintMusic. It is highly 

If you don’t read any 
other tutorials, do take a 
look at Tutorial 1a.
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recommended that you take a few moments to familiarize 
yourself with this tool: Select the Help Menu, then choose 
User Manual

SOME TERMINOLOGY

If this is your first encounter with a computer, you should take 
some time to learn the basics from its manual. If your computer 
didn’t come with an owner’s manual, many excellent books are 
now available on basic computer usage, often with insulting 
names like “Macintosh for Complete Morons” or “Windows for 
Blithering Idiots.” Despite such uninviting names, these books 
can be indispensable if you’ve never used a computer before. In 
any case, you should certainly familiarize yourself with your 
operating system, making sure that you understand important 
concepts such as pointing, clicking, double-clicking, dragging, 
and opening and closing windows.

This PrintMusic book assumes that you know how to choose a 
command from a menu and how to navigate through a dialog 
box. In addition, be sure you’re familiar with the parts of a 
window, including the scroll bars, the title bar, the close button, 
and the sizable frame.

In many applications, including this one, you’re sometimes asked 
to !-click (Mac: a-click) something on the screen. That 
simply means that while pressing the ! (or a) key, you 
click the mouse button—then release both. Once you’ve mastered 
that principle, the meanings of d-click and even !-d-
click should be clear.

Because PrintMusic does some things that music programs have 
never done before, you’ll also be running into terms we’re certain 
will be new to you. You’ll be introduced to these terms as you go 
through the tutorials. But keep in mind that if you encounter an 
unfamiliar term while using the program, you can learn about it 
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in the User Manual; just look up the dialog box or menu in which 
it appears.

SIMPLIFIED ORDER OF ENTRY

In general, you can make the 
most of your time by creating 
your documents in the 
following order. You may 
wish to refer to this list after 
performing the tutorials.

1. Specify the title, num-
ber of instruments, and beginning time and key signature. 
(See the Setup Wizard in Tutorial 1a.)

2. Enter the notes.
3. Listen to your piece to check for mistakes.
4. Edit the music.
5. Put in the lyrics.
6. Add repeats and chord symbols.
7. Put in all markings: dynamics (F ), articulations (U ), and 

slurs.
8. Verify that the music is spaced correctly.
9. Look the piece over. Resize the page to fit more music on the 

page, if desired. 
10. Fix bad page turns or system breaks.

See the Order of Entry in the 
“Making the Most of PrintMusic” 
chapter for more detailed steps 
after you’ve learned some 
important PrintMusic concepts.
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Tutorial 1a: Simple Entry

In this tutorial we’ll show you the easiest ways to start a 
new document and get notes on the page. There are three 
basic note entry methods, so we’ve divided this tutorial into 
three parts: Simple Entry, Speedy Entry, and HyperScribe. 
We recommend you start with the Simple Entry tutorial to 
get a good introduction to navigating around PrintMusic. 
Simple Entry is PrintMusic’s most basic entry method and 
also one of its most powerful. If you want, you can simply 
click notes onto the staff with a mouse. Or, for more speed, 
quickly type them in with your computer or play them in 
with a MIDI keyboard. As you enter, you can even enter 
articulations, expressions, and other items on the fly. By 
the end of this tutorial, you will be able to enter your nota-
tion into PrintMusic using the powerful options offered by 
Simple Entry.

CREATING A NEW DOCUMENT WITH THE DOCUMENT 
SETUP WIZARD

You are probably familiar with Wizards from other appli-
cations, such as word processors and spreadsheets. This 
Wizard is designed to help you set up a new PrintMusic 
document. Let’s create a simple piano score.

If you haven’t already started PrintMusic, do so now. When 
the Launch Window appears, click the Setup Wizard but-
ton. If PrintMusic is already started. click on the File Menu 
1
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and choose New, then Document with Setup Wizard. The 
“Select and Ensemble and Document Style” page appears.

This page lists ensembles and document styles you can use 
to customize a new document. For now, we simply need a 
single staff score in the standard Engraved style, so we’ll 
leave the Ensemble list as is and use the “Engraved Style” 
which is already selected.

• Click Next. The Add or Delete Instrument(s) page 
appears.

• In the first column, click on the word Keyboards. A list 
of common keyboards appears in the second column.

• In the second column, click on the word Piano; click 
Add. Now the third column contains the piano you 
intend to use in this score. 

You should be aware that the order in which the instru-
ments appear in the third column is the order in which 
they will appear, from top to bottom, in your score. If 
2
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you are creating a multi-instrument score and the Doc-
ument Setup Wizard incorrectly orders your instru-
ments, you can use the small up and down arrows to 
move the instruments around in the list until they are 
correct. 

Your Wizard should now look like this:
3



Tutorial 1a: Simple Entry

• Click Next. The Score Information page appears.

• Click in the Title box and type “Simple Gifts.” When the 
Wizard creates your score, your title will be centered at 
the top.

• Click in the Composer box and type “Traditional Shaker 
Song. ” 

• Click in the Copyright box and enter the year and your 
name after the © symbol. 

• Click Next. The Wizard asks for the time signature, key 
signature, initial tempo marking, and pickup measure. 

• Click the  button. 

• In the lower left quadrent of the box, click the up arrow 
once to set the key signature to G Major. 

• In the upper right, check the box next to Specify Initial 
Tempo Marking. Set the tempo to the default: 120 beats 

4

2
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per quarter note. This piece does require a pickup, so 
we’ll add that next. 

• Check Specify Pickup Measure and click the quarter 
note icon. The pickup is two eighth notes which equals a 
quarter note duration.

Your Wizard should now look like the following picture:

• Click Finish. PrintMusic now presents you with a new, 
Untitled document, displaying your “Simple Gifts” title 
and containing the piano staves in the correct key and 
time signature with a pickup measure and a tempo 
marking in the first measure. 

You could continue with this file, but let’s close it and 
open a file where we’ve completed the left hand for you.

• From the File Menu, choose Close. Save the file, if you 
wish. 

• Choose Open from the File Menu. Locate the document 
named “Tutorial 1a” in the PrintMusic 2008/Documen-
5
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tation/Tutorials folder, and double-click it. After a 
moment, you’ll see a simple piano arrangement of “Sim-
ple Gifts” come to the screen. 

The left-hand part has been prepared for you; in this 
tutorial, you’ll finish the melody.

Windows View

Simple
Entry

Palette

Playback ControlsMenu Bar

Main Tool
Palette

Page Counter

Document Window

Vertical
Scroll Bar

Title Bar

Horizontal 
Scroll Bar

Page Scroll
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Macintosh View

Take a look around the screen. Across the top, you’ll find 
the menu bar. You’ll be using these menus to control Print-
Music’s behavior, edit documents, change the view, and 
much more. There are eight unchanging menus; File, Edit, 
Utilities, View, Document, MIDI, Window,  and Help. Also, 
you will likely see another menu which corresponds to the 
tool currently selected in the Main Tool Palette.

Below the menu bar is the Main Tool Palette. Each square 
tile on these toolbars contains a symbol representing its 
function. Just about everything you do in PrintMusic will 
be in the context of one of these tools. You’ll also see the 
Simple Entry Palette: on Windows running vertically along 
the left edge of the screen, on Mac to the right of the Main 
Tool Palette. All of these toolbars can be hidden, providing 
you with more space to view your music, or they can be 
viewed as palettes that float in front of the music. To hide 
any toolbar, select it from the Window Menu to remove the 
check mark. Selecting it again will cause it to reappear. 

      Simple Entry Palette             Playback ControlsMenu Bar

Main Tool
Palette

Page Counter Page Scroll

Document 
Window

Vertical
Scroll Bar

Title Bar
(moves window)

Horizontal Scroll Bar
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(Note: Depending on your monitor's video resolution, the 
toolbars may first appear as palettes on your screen.

On Windows, the palettes are initially attached or 
“docked” to the edge of the window. To turn a toolbar into 
a floating palette, click on the edge of the toolbar and drag 
it out into the center of the screen, until you see a dotted-
line representation of a smaller palette. Release the mouse 
button. The palette can then be moved to any position on 
the screen. To restore a palette to toolbar status, double-
click. For now, leave the toolbars in their original posi-
tions.

The right side of the screen has a vertical scroll bar, which 
you’ll use to move the music you’re viewing up or down; 
and across the bottom of the screen is a horizontal scroll 
bar, which you’ll use to move left or right through your 
piece.

You’ll also see the Page counter; this number identifies the 
current page on the screen. To jump to any page in the 
score, highlight the current page number, then type a new 
number into the box and press j. (This piece has only 
one page.)

At the bottom of the window, you’ll see the Status Bar. On 
Macintosh, you’ll find the Message Bar at the top of the 
window.

• Click the mouse pointer across the tools on the Main 
Tool Palette. As the pointer touches (Win) or selects 
(Mac) each tool, the Status or Message Bar identifies it 
by name, and gives you the first instruction for how to 
use it.
8
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If you look at your score, you may notice that 
PrintMusic automatically fills any empty measures with 
a whole rest (hereafter called a default whole rest). 
That’s just to save you time. You’ll also notice that the 
music is displayed as a page of sheet music. 

If you’re new to computers, take a moment to click and 
drag (while holding down the mouse button!) across 
the menu titles at the top of the screen, noticing how 
the lists of commands drop down as you pass over each 
title.

• Click the Staff Tool icon s on the Main Tool Palette. 
Not only does the icon highlight, but there is now an 
additional menu on the menu bar: the Staff Menu. Some 
PrintMusic menus appear only when you select certain 
tools, so they’re out of your way until you need them.

Now that you’ve had a look around, let’s begin our mas-
terpiece. Click the horizontal and vertical scroll bar 
arrows until measure one is visible (if necessary).

ENTERING MUSIC WITH THE SIMPLE ENTRY TOOL

PrintMusic offers many different entry methods. The sim-
ple entry tool itself can be used to click notes onto a staff, 
or enter notes with your computer keyboard or with a MIDI 
keyboard. Here, you’ll learn how to enter notes using each 
of these methods.
9
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• Click the Simple Entry Tool 4. 

The Simple Entry Palette 
becomes active. From the 
Window menu, choose Simple 
Entry Rests Palette to show the 
Simple Entry Rests Palette. 
These palettes are shown on 
the next page. Also, another menu has appeared on the 
menu bar: the Simple Menu. This menu contains 
commands, a list of keyboard shortcuts, and other 
options that allow you to customize the way Simple 
Entry works. 

• From the Simple Menu uncheck Create New Measures. 
For this tutorial, all measures are already in place. In 
the future, you can recheck this option if you want to 
tell PrintMusic to automatically add new measures 
when the final measure has been filled. We’ll talk more 
about this and other Simple Entry Options later in this 
chapter. 

• From the Window Menu, choose Simple Entry Rests 
Palette. 

In addition to this 
tutorial, you can also 
open the file 
“EntryExercise” in the 
Tutorials folder for 
hands-on training.
10
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 Now, notice the two Simple Entry Palettes. 

Eraser

Double-whole Note

Whole Note

Half Note

Quarter Note

Eighth Note
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32nd Note

128th Note

64th Note

Dot

Sharp

Flat

Natural
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Tie

Tuplet

Grace Note

Double Whole Rest

Whole Rest

Half Rest

Quarter Rest

Eighth Rest

Sixteenth Rest

32nd Rest

64th Rest

128th Rest

Repitch
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You can click tools in the 
Simple Entry Palette to spec-
ify the rhythmic duration, 
and other attributes, prior to 
entering a note. The tools are 
divided into different groups. 
There are duration tools, like quarters, eighth notes, etc., 
accidental tools, like a sharp or flat, a tie tool, tuplet tool, 
and grace note tool. Click a duration tool to select it, then 
click an accidental, dot, or tie to modify the note. Notice 
your mouse cursor displays the tools selected in the Simple 
Entry palette. Click a modifier tool again to de-select it if 
you don’t want to use it anymore. To select any tool and 
clear all the other tools, double-click on it, or press the key-
stroke twice.  

You can mix and match the tools to 
build exactly the note you want to add, 
whether it’s a quarter note or a sharped, 
tied, dotted note that starts a triplet! 
Simply click in the staff to enter the 
note displayed on the mouse cursor. 
You can always select the note and edit 
it later using different, modifier key-
strokes, which we’ll talk about soon. 
The fastest way to enter notes in Simple 

Entry involves using keystrokes to select tools in the 
Simple Entry Palette, and then enter the notes using 
keystrokes on your computer keyboard, which we’ll do 
now.

• Now, click the Eighth Note Tool 4 on the Simple Entry 
Palette. The Simple Entry Palette contains an icon for 
each note duration. Notice the note with a vertical line 

To see a list of Simple Entry 
keyboard shortcuts from the 
Simple Menu, choose Simple 
Edit Commands and Simple 
Navigation commands.
12
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at the beginning of the first measure. This line is called 
the Simple Entry Caret. The caret is much like a cursor 
in a word processing program. You’ll learn how to 
quickly type in music using the caret soon.
For now, move the mouse cursor above and below the 
staff. Notice PrintMusic draws temporary ledger lines 
to help you place new notes. The cursor also changes to 
show you where you are and what will happen if you 
click the mouse. Currently, a ghostly quarter note 
should be floating above your music, waiting for your 
click to place it into the score.  

• Position the mouse cursor over 
the D just below the staff and 
click. Finale places an eighth 
note where you clicked.

• Click just to the right of the 
existing note to enter the 
second eighth note. Finale 
beams the eighth notes together 
and spaces out the pickup measure accordingly. The 
next note is a quarter note, so we’ll need to change the 
duration.

• Click the Quarter Note Tool in the Simple Entry 
Palette. The cursor changes to a quarter note.

• Position the cursor over the second line G in the top 
staff of measure 1 and click. A quarter note appears on 
the second line G. You could click the Simple Entry Pal-
ette to choose each new duration as you enter, but it’s 
much faster to use the numeric keypad. Each key in the 
numeric keypad corresponds to a different note dura-
tion. 3 for a sixteenth note, 4 for an eighth note, 5 for a 
quarter note, and so on.
13
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• Press 4 in the numeric keypad. This is the same as click-

ing the Eighth Note Tool. You are now ready to continue. 

• Position your 
cursor on the 
second beat 
of measure 
one and click 
in the next 6 
notes. Use 
the image to 
the right as a guide. If you miss and click the wrong line 
or space, use the up and down arrows to move the note 
to the correct staff position. Notice you can use the left 
and right arrows to move the selection from left to right.

• Finish entering 
measures 3 
through 5 shown 
to the right. If 
you enter the 
wrong note dura-
tion, simply hold 
down the @ 
key (b key on Mac), and press the correct duration 
key in the numeric keypad to edit the note you just 
entered. (Remember, 4=eighth note and 5=quarter note).  

If you ever make a mistake, you can also use the Eraser 
ø in the Simple Entry Palette to remove items in the 
score. Click the Eraser Tool, and then click a notehead 
to remove the note. Click above or below a chord to 
remove the whole chord. Click on an accidental, tuplet, 
tie, or dot to remove it.
14
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Now, although it would be fast to simply click in mea-
sure 6, let’s use the Selection Tool to copy and paste 
measure 5 to a couple of other measures that require 
identical notation.

• Click the Selection Tool 

. 

• Click measure 5 in the 
top staff. The measure 
is now highlighted. 
You’ve just selected it, or told PrintMusic that this is the 
measure you intend to manipulate.

• Drag the measure so it is superimposed on measure 6 
(the first measure in the second system). A dotted out-
line of the selected measure moves with the cursor, 
showing exactly where PrintMusic will copy the music.

• Release the mouse button. Voila! You’ve just copied the 
music from measure 5 into measure 6. Alternatively, you 
could have highlighted measure 5, pressed (Win) !/

If you make a mistake, click on 
the Edit Menu and choose Undo. 
Or, hold down the Ctrl ! 
(Mac: Command a) key and 
press Z.
15
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(Mac) a-C, then highlighted measure 6 and pressed 
(Win) !/(Mac) a-V.

• Click measure 6 so it is highlighted. Instead of dragging, 
you can also use a keyboard shortcut to copy and paste 
this measure anywhere in your score.

• Windows users hold down the ! key, Mac users, 
b, and click measure 13, top staff. The quarter notes 
appear in measure 13. Now, let’s use the Simple Entry 
Caret to type in some notes.

• Click the Simple Entry Tool 4 again. 

• Hold down the Ctrl key (Mac users, the Option key), 
and click the second quarter note in measure 6. The 
note changes color indicating it is now selected.

• Press the right arrow key h to invoke the Caret on beat 
1 of measure 7. The same principles used for clicking 
also apply to typing. First select the duration using the 
numeric keypad, then specify the pitch, this time using 
the arrow and letter keys.

• Press the 4 key in the numeric keypad. The note on the 
caret changes to indicate the duration just like the 
mouse cursor. You should now see an eighth note on the 
third line B, beat 1 of measure 7.

• Press Enter the f key and then j. Finale enters an 
eighth note on the pitch specified. The caret moves to 
the ‘and’ of beat 1. The Enter key enters the note dis-
played on the caret.

• Press e. The note on the caret moves up to middle line 
B. 
16
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• Press Enter j again. Another eighth note appears. 

You could continue to enter the remaining notes using 
the arrow keys to specify the pitch, but there is a faster 
way—just type the note letter.

• Type A, F, and then D. Finale enters the next three 
notes. We need to change the D to a quarter note, so 
we’ll do that next.

• Windows users, hold down Alt, Mac users, Option, and 
press 5 in the numeric keypad. The D at the beginning of 
measure 8 changes to a quarter note. Notice the dura-
tion of the caret remains the same, so you can easily 
continue entering eighth notes.

• Complete entering 
measures 8, 9, and 
10. Use the letter 
keys to enter the G, 
F, G, A, and B. Then, change the B to a quarter note by 
holding down Alt/Option and pressing 5. Then enter the 
two As. When you are done the last note of measure 10 
should be selected. Now, let’s explore some other Simple 
Entry functions—say we want to enter an eighth rest.

• Press 0 (zero). PrintMusic 
adds an eighth rest. The 0 
key adds a rest of the dura-
tion currently chosen in the 
Simple Palette. 

• Press Delete. The rest disappears and the previous note 
is selected. Now, let’s add an articulation to this note.

You can also press the R 
key to change a selected 
note to a rest.
17
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• Press the * key in the numeric 

keypad. The Articulation Selec-
tion dialog box appears. 

• Choose the accent marking (>) 
and click Select. An accent 
appears on the note. 

• Hold down ! (Mac: a) 
and type Z to undo. The articu-
lation disappears.

Now, notice the 10th measure of 
“Simple Gifts” has the same 
rhythm as the 11th and 12th measure. This is a good 
opportunity to demonstrate how copying music and 
repitching a melody can save time.

For the following we’ll use the Selection Tool again. 
Note that you can also use any tool that permits regional 
selection for copying, moving, and erasing music.

• Click the Selection Tool .  

• Click measure 10 of the top staff. The measure is now 
highlighted. 

• Windows users, press !-C, Mac users, a-C. You 
have just placed this measure on the clipboard and can 
now past it anywhere you wish. 

• Click measure 11 and Windows users, press !-V, 
Mac users, a-V. The music appears in measure 11. 
This method is particularly useful for copying music to 
measures on a different page. Now, say instead of just one 
copy off the source material, we want to mast multiple 
copies...

You’ll learn more about 
how to enter 
articulations, and edit 
them, in chapter 3.
18
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• Click the Edit Menu and choose Undo Mass Paste. The 

music in measure 11 disappears. The music in measure 
10 is still in the clipboard and measure 11 is still high-
lighted.

• Windows users, 
preass @-
!-V, Mac 
users, a-c-
V. The Paste Multi-
ple dialog box 
appears. 

• Enter 2 in the 
“Paste Horizon-
tally” text box and click the OK button. Instead of click-
ing OK, you could press the j key; in PrintMusic, 
pressing j is the same as clicking the OK button. Finale 
pastes the music to both measures 11 and 12.

• Click the Simple Entry Tool 4. Now that we’ve got the 
right rhythms, let’s repitch measures 11 and 12 accord-
ingly.

• Click the Repitch Tool  in the Simple Entry Palette. 
The Repitch Tool allows you to quickly change pitches 
of existing notes.

• Click the first note in measure 11. The middle space B is 
now selected. 

• Type the pitches (B, B, C, D, 
C, B) to complete measures 11 
and 12. If you are using a 
MIDI keyboard, note that you 
19
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can also simply play the pitches. You will learn more 
about MIDI input soon.

• Windows users, hold down !, Mac users, a, and 
press f. Selection moves to the bottom staff. Hold 
down !/a and press f again to select the low-
est note of the chord. 

• Press h. Selection moves to the next measure in the 
bottom staff. Using the arrow keys, you can navigate to 
any note in your score. 

• Windows users hold down !, Mac users, b and 
click the second quarter note in measure 13. Then, press 
5 in the numeric keypad, and then press h. The caret 
appears on the first beat of measure 14.

If you have a MIDI device, such as a MIDI keyboard, you 
can use it to easily specify pitches in Simple Entry. (If 
you do not have a MIDI device, skip to the step marked 
[Non-MIDI users]). First, ensure your MIDI device is 
properly configured with your computer (See earlier 
chapters INSTALLATION FOR WINDOWS or INSTALLATION 
FOR MAC (depending on the platform you are using) for 
information on setting up a MIDI device). Then continue 
with the following steps.

• From the Simple Menu, ensure Use MIDI Device for 
Input is checked. If it is not, select it from the menu. 

• On your MIDI device, play B4 (B above middle C). Print-
Music adds a B to the measure and the caret advances to 
the right. A note played on the MIDI device is the same 
as pressing Enter or a note letter on your computer key-
board. Simply choose the duration on the numeric key-
pad and then play the pitch to continue entering.
20



Tutorial 1a: Simple Entry

• Press 4 in the numeric keypad and then play B and A. 

Then press 5, and play G twice. Then press 6 and play G 
once more to complete the phrase. In the future, note 
that you can play multiple notes simultaneously to spec-
ify a chord. Also note that Finale adds any accidentals 
accordingly. Feel free to use a MIDI keyboard to specify 
pitches in place of your computer keyboard or mouse for 
the remainder of this tutorial. If you just used your 
MIDI device to complete the phrase, skip the next step.

• [Non-MIDI users] Type B, 4, B, and A. Then type 5, G, 
G, 6, G to complete the phrase. Remember to use the 
numeric keypad for the duration numbers.  
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Tutorial 1a: Simple Entry

Congratulations! You’ve completed your first PrintMusic 

melody.

You can use additional Simple Entry keyboard shortcuts to 
add ties, grace notes, articulations, and even clef, key, and 
time signature changes. See SIMPLE ENTRY in the User Man-
ual for detailed info. Also, while using Simple Entry, right-
click (Mac c-click) a note or rest to invoke a context 
menu which allows you to hide the note, change it to a rest, 
and make other changes. Or, from the Simple Menu, choose 
Simple Edit Commands to see a list of options. Each of 
these commands can also be applied with a keyboard 
shortcut. In addition to using the list of keyboard shortcuts 
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Tutorial 1a: Simple Entry

under the Simple Menu, you can also refer to your Quick 
Reference Guide.

As we mentioned earlier, 
you can adjust the behav-
ior of Simple Entry by 
changing items available 
under the Simple Menu 
such as: Check for Extra 
Notes, Fill with Rests at 
End of Measure, and Play-
back Notes on Entry. 
When Check for Extra 
Notes is selected (this 
command is selected by 
default), PrintMusic will 
consult the time signature 
and not allow you to inadvertently enter extra notes in a 
given measure. Fill with Rests will add enough rests to fill 
the measure if you leave the measure and start entering 
notes in another measure.. 

ACCIDENTALS

Let’s add some blues to our melody line to illustrate how to 
add accidentals. If using the mouse or the Caret, you can 
specify an accidental by choosing both a duration tool and 
an accidental tool prior to entering the note. You can also 
specify accidentals as you enter notes by using keystrokes 
to apply a sharp (+ key) or flat (- key) to the note you just 
entered. By selecting an accidental tool exclusively, you can 
click to add accidentals to any note in the score. The Sharp 
Tool m and the Flat Tool o add a sharp or flat to the 
note, if needed by the key signature. If you use the Half 
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Step Up Tool ® or the Half Step Down Tool , you’ll 
raise or lower the note. If the note is already sharp, raising 
the note will add a double-sharp.

• Click the Selection Tool . First, we’ll clear a measure 
to show how to enter accidentals while entering notes.

• Click measure 9 in the top staff so it is highlighted, and 
then press $ (Mac: o). This method clears all 
entries in the selected region.

• Click the Simple Entry Tool 4. 

• Click the Eighth Note Tool 4, or press numeric keypad 
4, and then enter a second line G at the beginning of 
measure 9. An eighth note appears in measure nine.

• Press + (plus) on the numeric keypad. PrintMusic adds 
a sharp to the note.

• Press - (minus) on the numeric keypad  twice. The note 
is now flat. PrintMusic alters the pitch of the note chro-
matically with each keystroke. You can also use the 
Sharp m and Flat o Tools in the Simple Entry Palette 
to specify an accidental before entering a note.

• Click the Flat Tool o in the Simple Entry Palette. Now 
both the eighth note and the flat are selected in the 
Simple Entry Palette.

• Press the right arrow h key to activate the caret. 

• Type F. PrintMusic places an 
F flat on the staff. Notice an 
F flat is actually a whole step 
down from the diatonic 
because we are in the key of 
G. In this way, the Flat Tool 

√
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is said to be ‘absolute’—not relative to the key signa-
ture.

• Double-click the eighth Note Tool 4 (or press numeric 
keypad 4 twice) to deselect all other tools.

• Finish entering the measure by typing G, and then A. 
Notice PrintMusic does not add a natural on the G. 
That’s because Simple Entry’s accidentals are ‘smart.’ 
In other words, they apply through the remainder of the 
measure. Of course, you can always add or remove acci-
dentals manually where needed to override a smart 
accidental. Now, let’s use the mouse to edit existing 
notes.

• Double-click on the Flat Tool o. Only the Flat Tool is 
selected.

• On the last note of measure 9 in the top staff, click on 
the A. An A flat appears next to the quarter note.

• Click on the Half Step Down Tool . Click the A 
again. A double-flat appears next to the A. The Half 
Step Up/Down Tools are ‘relative’ - they increment the 
pitch up or down a half step with each click. When you 
selected the Half Step Down Tool, the Flat Tool auto-
matically deselected. You can only have one accidental 
tool selected at one time. Let’s try a sharp now.

• Click on the Sharp Tool 
m. Click the first note of 
measure 9 (G flat). A 
sharp appears next to the 
note. Also notice Finale 
automatically places a 
flat on the second G flat 
because it is no longer 

√
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implied by the first. Because this melody probably 
wouldn’t sound too great, we’ll remove the sharp and 
the double-flat.

• Click on the Eraser Tool ø. 

• Click the Sharp and the double-flat to remove them. 
These items disappear as you click.

CHORDS

Building chords is a snap with Simple Entry. To 
add notes with the mouse, just select the same 
duration icon as the note already entered, then 
move the cursor above or below a note. Notice 
vertical lines appear above and below the note 
as shown to the right. This indicator tells you 
that a click will add a note to the chord. While entering 
with the Simple Entry Caret, simply press the number that 
corresponds to the interval above or below the selected 
note to add it to the chord. Let’s try entering and adding 
chords to the left hand.

• Click the Selection Tool . First, we’ll clear a measure 
to use for this example.

• Click and drag over measures 7 and 8 in the bottom 
staff so they are highlighted, and then press $ 
(Mac: o). 

• Click the Simple Entry Tool 4, and double-click the 
Quarter Note Tool 5. 

• In measure 7, click on the A (top line) in the left hand. 
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• Move the cursor down a 

third to the F line and click. 
Now, click the middle line 
D. A chord with D, F, and A 
are added to the measure. 

• Press j to activate the caret. The caret appears. 

• Type D to enter a D on beat 2. Now, you can type an inter-
val to add additional notes in a chord.

• Type 4 on the number row above the QWERTY keyboard. 
PrintMusic adds a note of the same duration a fourth 
above the D (G). Notice the G is now selected. To add 
another note a third above G, you would type 3. You can 
also add notes to a chord using note names.

• Hold down d and press 
E. Finale places an E in the 
chord. Note holding down 
d and pressing 3 would 
have also added the E. Print-
Music automatically moves the D notehead, as an interval 
of a second, to the left of the stem. Now, the caret should 
appear at the beginning of measure 8 on the bottom staff.

• Press h.

• If you are using a MIDI 
device, play the triad D3, F3, 
and A3 simultaneously to 
enter the next chord, then 
play C3, F3, and A3 to finish 
the measure. You can play up to 12 notes at once to add a 
chord.    

While entering chords, hold 
down d and type an 
interval to add notes lower 
than the selected pitch.
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• If you are not using a MIDI device, type the following 

(use the number row for numbers): D, 3, 3. Then C, 4, 
and 3 to complete the measure. 

TUPLETS

Tuplets are any irregular grouping, including triplets, quin-
tuplets, and so on. We’ll cover tuplets briefly here; see 
TUPLETS in Tutorial 1b for a more in depth lesson. Let’s 
enter a triplet to the second beat of measure 7, and then 
learn how to change existing entries to a triplet.

• Click on the Eraser Tool ø, then click on the last two 
notes in measure 7 in the top staff. First, we’ll place the 
caret in the staff as if we were entering this music for the 
first time.

• Hold down ! (Mac: b) and click the middle line 
B in measure 7. The note is selected.

• Press j. The Caret appears on beat 2.

• Type numeric keypad 4 and then A to add the first eighth 
note. 

• Press numeric keypad 9 (or 
QWERTY 9) to begin a triplet. 
PrintMusic adds a triplet 
bracket and automatically fills 
out the triplet with rests as 
shown in the image to the right. The note you just 
entered is the first note of the triplet. Now, you can type 
the letter names to fill the triplet with notes.

• Type F and E to complete the triplet. The cursor 
advances to the next measure. You can also use the 
mouse to change an existing note to a triplet. 
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To click a tuplet onto the staff with your mouse, choose 
the rhythmic duration and the Tuplet Tool in the Sim-
ple Palette, and click to create the tuplet. Then, simply 
click the rests to fill in the tuplet. PrintMusic will ignore 
attempts to create a nested tuplet with the Simple 
Tuplet Tool. If you want nested tuplets, ratios, or other 
fancy tuplets, see the TUPLET TOOL in the User Manual.

Now, we’ll change the first three eighth notes in mea-
sure 2 to a triplet.

• Double-click the Tuplet Tool ] on the Simple Entry 
Palette. Only the Tuplet ] icon should be highlighted 
in the Simple Palette.

• Click the first beat on the top staff, measure 2. The 
existing eighth notes are now enclosed in a triplet 
bracket. 

To enter more advanced tuplets, hold down @ 
(Mac: b) and press numeric keypad 9 when using 
the caret. Or, hold down d and click the score. The 
Simple Entry Tuplet Definition dialog box appears 
where you can specify more advanced tuplets such as 
quintuplets, septuplets, and the like. See SIMPLE ENTRY 
TUPLET DEFINITION DIALOG BOX in the User Manual for 
details. 

CHANGING THE KEY SIGNATURE, TIME SIGNA-
TURE, AND CLEF

While entering with Simple Entry, you can use keyboard 
shortcuts to change the key and meter. 

• Hold down ! (Mac: b) and click on any note in 
measure 1. For this example, we’ll select a note with the 
mouse. In the future, you can use this method at any 
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time while entering with the Simple Entry Caret, or 
whenever a note is selected in the score. The key and 
time signature change appears at the beginning of the 
measure you are editing (unless specified otherwise in 
the Key or Time Signature dialog box). Clef changes 
appear at the position of the caret, or to the left of a 
selected note.

• Hold down @ (Mac: b) and press K. The Key 
Signature dialog box appears.

• On the scroll bar to the right of the key signature 
display, click the up arrow twice. We’ll change the key 
signature to A major. 

• Click OK. The key change appears at the beginning of 
the first measure. You’ll learn more about the Key 
Signature dialog box in chapter 2. Now let’s say we 
want to change the time signature.

• Hold down @ (Mac: b) and press T. The Time 
signature dialog box appears. Here, you can change the 
number of beats and beat duration using the arrows on 
the right. For now, leave the time signature set to 
common time. You’ll learn more about this dialog box 
in chapter 2.

• Click OK. Now, let’s say we want to change the clef.

• Hold down @ (Mac: b) and press C. The Change 
Clef dialog box appears.  

• Select a new clef and click 
OK. You return to the score. 
PrintMusic creates a clef 
change at the beginning of the 
measure (just to the left of the 

You’ll learn more about 
key signature, time 
signature, and clef 
changes in chapter 2.
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barline). You’ll learn more about clef changes in chap-
ters 1c and 5.

ADDING MEASURES

Although this tutorial has the right number of measures, 
there will undoubtedly come a time when you need to add 
more. This can be done in several ways. First of all, if you 
are using the Simple Entry Caret, PrintMusic will automati-
cally add a measure when you fill the last measure of the 
score. Therefore, you can simply continue entering notes 
and PrintMusic will create the measures for you. You can 
also use the Edit Menu to add measures at any time. To do 
this, from the Edit Menu, choose Add Measures. In the Add 
Measures dialog box that appears, type in the number of 
measures to be added, and click OK. To add a single mea-
sure, just double-click the Measure Tool.

Note that as you add mea-
sures, the final barline will 
move to the last measure of 
the score. 

SAVING YOUR WORK

When you opened this document, the computer transferred 
the song from the hard disk into its memory; at this 
moment, all the changes you’ve made to “Simple Gifts” 
exist only on the screen. If someone trips on the computer’s 
power cord at this moment, all of your work will be lost, 
and you’ll be left with the original, incomplete “Tutorial 
1a” document.

To delete measures, click on the 
Selection Tool, double-click to 
select a measure stack, then 
press the Delete k.
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For this reason, it’s a good idea to save your work back 
onto the disk at regular intervals—perhaps every 15 min-
utes or so. To save your work on the disk: 

• From the File Menu, choose Save or press !-S 
(Mac: a-S). Your changes have now been saved on 
the hard disk. (You still have a fresh, untouched copy of 
this document, however; it’s on your original PrintMu-
sic disc.)

Once you’ve saved a file, each time you subsequently 
choose Save from the File menu, PrintMusic will make a 
backup copy of the previous saved version. The copy 
can be distinguished by both the .BAK extension and 
different icon when viewed in Windows Explorer. See 
the User Manual under BACKUP FILES for instructions.

WHEN YOU’RE READY TO CONTINUE

From the File Menu, choose Close to close the active docu-
ment and all open windows on that document. If you haven’t 
saved your work, PrintMusic lets you know, and gives you the 
option of saving the changes or leaving the document as it was 
when it was last saved.

A diagram showing which keys correspond to which rhyth-
mic values or commands appears on your Quick Reference 
Guide. If you want to take time out for some experimenta-
tion before proceeding to Tutorial 1b, choose Default Docu-
ment from the New submenu of the File Menu. PrintMusic 
will open a new “Untitled” document.

If you’re ready to move on, go right ahead to the next tuto-
rial. If you’ve had enough for one lesson, choose Exit (Mac: 
Quit) from the File Menu.
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FOR MORE INFORMATION

Some of the entries in the User Manual contain discussions 
of topics you’ve just covered. See, for example:

ACCIDENTALS SAVE (FILE MENU)
ARTICULATION TOOL SIMPLE ENTRY

COPYING  MUSIC TIME SIGNATURE TOOL

KEY SIGNATURE TOOL TUPLET TOOL
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In addition to Simple Entry, Speedy Entry offers another fast and 
efficient method of music entry. This tool is particularly useful if 
you plan to use a MIDI device for input. You can enter music very 
quickly, with one hand on a MIDI keyboard and the other on the 
numeric keypad, or using the MIDI device exclusively. You can 
also edit existing music with equal ease.

In this tutorial, you’ll explore the Speedy Entry Tool in depth, 
and you’ll get to know some more of PrintMusic’s MIDI input and 
playback capabilities. We assume you’ve already read about 
basic navigation of the PrintMusic screen in Tutorial 1a: Simple 
Entry. By the end of this tutorial, you should know how to get 
your notes on the page quickly with the Speedy Entry method.

A WORD ABOUT MIDI

MIDI (for Musical Instrument Digital Interface) is an electronic 
language spoken by computers and MIDI devices. Most MIDI 
devices are keyboards, but there are also guitar, string, wind, per-
cussion, and even voice MIDI controllers. As mentioned earlier, 
the term MIDI keyboard will be used to refer to whatever MIDI 
device you’re using.

If you need help hooking up your MIDI device, look at the section 
called SETTING UP YOUR MIDI SYSTEM in the INSTALLATION 
CHAPTERS earlier in this book. If you begin this tutorial and find 
that your MIDI keyboard isn’t operating correctly, you may want 
to consult the User Manual under MIDI SETUP DIALOG BOX.

Remember, a MIDI keyboard isn’t required for Speedy Entry.

CREATING A NEW DOCUMENT FROM A TEMPLATE

PrintMusic comes with more than 30 different kinds of templates 
(piano-vocal scores, choral setups, chamber orchestra scores and 
so on) to help you get started. Not sure what size to make your 
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concert band score so all of the instruments fit vertically on a 
page? Use the template. Occasionally write a pop lead sheet that 
doesn’t use classical formatting? Use the Lead Sheet template. If 
you find you use a particular template every single time, you may 
wish to make it your default file—the template the Setup Wizard 
uses.

We’ll start this tutorial with the Lead Sheet template and create 
an arrangement of the folk song “Oh, Susannah.” If you haven’t 
already started PrintMusic, do so now. Close any documents that 
may be open or cancel out of the Wizard.

• From the File Menu, choose New, then select Document from 
Template. 

• In the Templates folder, double-click on General Templates, 
then scroll down and select Lead Sheet. Click Open. The last 
two pages of the Setup Wizard appear. We don’t need to make 
any changes here for now.

• Click Next and then Finish. PrintMusic will open a new, Unti-
tled file with one staff and thirty-one empty measures.

SPEEDY ENTRY

• Click the Speedy Entry Tool a. 
Another menu appears—the 
Speedy Menu—whose commands 
govern the behavior of this tool. 
Just to check, hold the mouse but-
ton down on the word Speedy so 
that the menu drops down, and make sure that there’s a check 
mark beside Use MIDI Device for Input.

If you’re ever stranded without a MIDI keyboard, there are 
two ways in which you can enter music with the Speedy Entry 
Tool when the Use MIDI Keyboard for Input option is turned 
off. See the User Manual under SPEEDY ENTRY for details.

If you’re not using a 
MIDI keyboard, make 
sure Use MIDI Device 
for Input is unchecked in 
the Speedy Menu.
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If Auto Launch is turned on, the measure sprouts a rectangu-
lar frame. If not, click on the first measure. In the frame, 
you’ll see a thin vertical cursor at the left side of it, called the 
insertion bar. There’s also a short horizontal cursor called the 
pitch crossbar, which indicates pitch.

Use the up/down arrow keys to move the pitch crossbar, and the left/right 
arrow keys to move the insertion bar.

• Play middle C on your MIDI key-
board. While holding down the 
key, press the 5 key on your com-
puter keyboard. If your MIDI sys-
tem is hooked up correctly, a 
middle C quarter note appears. If 
your MIDI keyboard is not sending 
correctly to the computer, you’ll see 
a quarter rest; in which case, see 
SETTING UP YOUR MIDI SYSTEM in the INSTALLATION 
CHAPTERS earlier in this book. To remove the rest, click it and 

press k.

Why did you press 5? The number keys, both on the numeric 
keypad and on the top row of the alphabet keyboard 
(QWERTY keyboard), have special meanings to PrintMusic. 
(Be sure to press the Num Lock key if you’re using the 
numeric keypad.) In PrintMusic, 5 means a quarter note. Take 
a look at these diagrams:

� �
Editing Frame

Pitch Crossbar

Insertion bar

To use Speedy Entry 
without a MIDI 
keyboard, use the arrow 
keys to place the 
insertion bar on the 
pitch, then press the 
duration number key.
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Windows Speedy Entry Keypad Commands
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Since the MIDI keyboard is providing PrintMusic with the 
pitch information, all you have to do to provide the rhythmic 
information is press the proper number key. If you’re holding 
down a MIDI keyboard key when you press a number key, you 
get a note. If no MIDI keyboard key is being held down when 
you press a number key, you get a rest. 

• Hold down the D key on your MIDI keyboard and press the 5 
key again; then E (and press 5); then F (and press 5). You’ve 
just built the first four notes of a C scale. Before you could 
really see what you’d done, however, PrintMusic advanced the 
editing frame to the next measure, ready for you to play more 
notes. 

Note that entry with a MIDI device using Speedy Entry is in a 
way opposite from using a MIDI device with Simple Entry. In 
Simple Entry, the note duration is specified in the Simple 
Entry Palette before playing the pitches. In Speedy Entry, the 
pitches are held down prior to specifying the rhythmic dura-
tion. To lock Speedy Entry to a duration (like in Simple 
Entry), see the User Manual under SPEEDY ENTRY—TO 
ENTER MANY NOTES OF THE SAME VALUE.

You can turn off this auto-advance feature, which advances to 
the next measure as soon as the first one is rhythmically full:

• Press the zero (0) key to exit the editing frame, or click the 
mouse on any blank part of the screen. The editing frame goes 
away.

• From the Speedy Menu, choose Jump to Next Measure. If you 
click the Speedy Menu again, you’ll see that Jump to Next 
Measure no longer has a check mark in the Speedy Menu; 
you’ve just turned the auto-advance feature off.

• Press the zero key again. The 0 key also takes you back into 
the editing frame you were last in.

Now that you’ve turned the Jump to Next Measure feature off, 
how will you move from measure to measure?
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• Press the left bracket ( [ ) key on your keyboard. PrintMusic 

moves you back to the first measure. The left and right 
bracket keys move the current editing frame one measure to 
the left or right, respectively.

• Now press the left arrow and right arrow keys on the key-
board a few times. The insertion bar moves by one note or rest 
each time you press the right or left arrow key. You can also 
move the insertion bar by clicking a note with the mouse.

EDITING WITH SPEEDY ENTRY

• Position the insertion bar on the first note (middle C) and 
press the 4 key. In PrintMusic, 4 means an eighth note, so 
your middle C quarter note has just changed duration (rhyth-
mic value). In PrintMusic, if you enter a rhythm incorrectly, 
there’s no need to delete the note and reenter it; simply line up 
the insertion bar with the note and press the desired duration 
key.

Whenever you change a note’s duration (or enter a new note), 
the insertion bar moves to the right, ready for you to enter a 
new note or rest (or to change the rhythmic value of an exist-
ing note).

• Press the 4 key three 
more times. You’ve 
now changed all four 
notes in this measure 
to eighth notes. 
They’re automatically beamed.

• Position the mouse pointer squarely on the last note’s note-
head. Click and drag this F to the F line an octave higher. In 
Speedy Entry, you can move notes to other pitches by drag-
ging them in this way. (If your MIDI keyboard is connected 
properly, PrintMusic plays the note each time it changes 
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pitch. This feature can be disabled by deselecting Playback 
from the Speedy Menu.)

• Click squarely on the high 
F’s notehead. With the 
button down, drag it 
slightly to the right or left. 
The Speedy Entry Tool 
gives you complete con-
trol—not only of a note’s 
pitch, but also of its posi-
tion in the measure.

If you want to drag a note only horizontally (so that you can’t 
drag it off of its pitch), or only vertically (so that you can’t 
drag it left or right), press the d key while you’re drag-
ging.

• Move the insertion bar to the third note in the measure (the 
E). Remember, you move the insertion bar by pressing the 
arrow keys or by clicking a note.

• Press k. Pressing the k key removes a note, rest, or 
chord from the score.

But what if you delete a note by accident? Any time you’re 
working with the Speedy Entry Tool, remember that you can 
undo your last action by choosing Undo from the Edit Menu.

• From the Edit Menu, choose Undo (or press !-Z) (Mac: 
a-Z). The note you deleted reappears.

To prepare for the next exercise, change all four notes back to 
quarter notes:

• Move the insertion bar back to the middle C, and press the 5 
key four times. 
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Tutorial 1b: Speedy Entry

WORKING WITH CHORDS

• Position the insertion bar on the F, and use the up/down 
arrows to move the crossbar to the third-space C. 

• Press j. There are now two notes in the chord. Using the 
four directional arrows, you can maneuver anywhere in a 
measure, and using the j key, you can add a note to an 
existing note or chord. (If the insertion bar is on a rest, j 
turns the rest into a note.)

Try moving the crossbar up and down the notes of this chord. 
If you hold down the up arrow key long enough, PrintMusic 
will add so many ledger lines that the measure you’re working 
on scrolls downward (or upward, if you’re pressing the down 
arrow key).

• Double-click the second-space A of the same chord. Double-
clicking is another way to add a note to a chord.

• Use the up arrow key to position the crossbar squarely on the 
top notehead (F) of the chord. Press $(Mac: o). The 
$ (o) key is the opposite of j: it removes a note from 
a chord. (If there’s only one note in the chord, this keystroke 
turns it into a rest.)

ACCIDENTALS

• Position the crossbar on the C of this chord. Press the plus (+) 
key on the numeric keypad. The note sprouts a sharp. The 
plus key raises the note by a half step.
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• Position the crossbar on the A and press the minus (–) key. 

You guessed it: the minus key lowers the note by a half step.

But what if you decide that a note has been “spelled wrong” 
enharmonically? You can always flip a note to its enharmonic 
equivalent by using the 9 key.

• Leave the crossbar on the Af and press the 9 key. The spelling 
of the note changes to Gs.

• Move the crossbar down away from the two notes. Press the 9 
key several times. If the crossbar is on a chord’s stem and not 
on a notehead, pressing the 9 key cycles a chord through vari-
ous enharmonic spellings.

For the moment, cycle through until the lower note is an Af. In 
the next step, you’ll hide the accidental.

• Position the crossbar on the Af. Press the asterisk (*) key. 
You’ll usually want to use the asterisk key on the numeric 
keypad. If you prefer, however, you can press d-8 (the 
main keyboard asterisk) instead.

Pressing the asterisk key hides an accidental—or, if none is 
there, it causes an accidental to appear. The note retains its 
identity—the note that now looks like an A will still play back 
as an Af. To restore the accidental, press the asterisk key 
again.

PrintMusic can even put an accidental in parentheses—simply 
press the letter p key. See the User Manual under COURTESY 
ACCIDENTALS.
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TUPLETS

You haven’t explored PrintMusic’s tuplet (triplets, quintuplets, 
and so on) features in Speedy Entry yet. Scroll to measure 2—
which is empty—and try the Tuplet Tool.

• Click the Speedy Entry Tool a, and click measure 2. 

• While playing any MIDI keyboard key, press the 5 key four 
times. You’ve just entered four quarter notes on the same 
pitch.

If PrintMusic doesn’t automatically advance the editing frame 
to the next measure, press the right bracket key ( ] ).

• Press !-3 (Mac: b-3). You do this before entering a 
triplet; PrintMusic puts a tiny “3” in the upper right of the 
editing frame, letting you know it’s expecting the next three 
notes to constitute a triplet.

• While playing any MIDI keyboard key, press the 6 key three 
times. As soon as the third note appears, PrintMusic centers 
the “3” over the triplet. You’ve just created a half-note triplet.

• Press the 0 (zero) key to exit the editing frame. In measure 2, 
you have four quarter notes; in measure 3, you have a half 
note triplet. You can modify each with the Tuplet Tool.

• Click the Tuplet Tool ] in the Main Tool Palette. Click the 
first quarter note in measure 2. The Tuplet Definition dialog 
box appears.

At the top of the screen there are various options for defining 
the temporal (time) definition of the triplet. Using these drop-
down lists and text boxes, you’ll answer the question, “How 
many of what value are to be played in the time of how many of 
what value?” Look at the two text boxes at the top of the Tuplet 
Definition dialog box. As you see, PrintMusic has guessed that 
you want to fit three quarter notes in the time of two—precisely 
the definition of a quarter-note triplet.
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In the Display section, there are checkboxes where you can 
specify how the triplet should look in the score. Should it 
have a bracket? Should it have a number? For now, the 
default settings are fine.

• Click OK. You’ve just turned ordinary quarter notes into a 
triplet by clicking the first of them with the Tuplet Tool. (You 
can edit the tuplet to look any way you’d like.) Notice the six 
handles that appear. These handles control the various ele-
ments of the bracket:

You can modify the triplet you made in Measure 3, too.

• Click the first note of the triplet in measure 3. The tuplet han-
dles appear.

• Drag the handles until the triplet appears the way you want it 
to. 

You can create tuplets within tuplets, too. It doesn’t matter 
whether you begin by creating the inner or outer tuplet. 

3
Drag this handle to independently 
move the bracket from the num-

Drag this handle to 
change the angle of the 

Drag this handle up or 
down to change the length 
of the “hook.”

Drag this handle to move the 
number relative to the bracket.

Drag this handle to move the 
entire bracket and number.
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INSERTING NOTES OR RESTS

• Click the Speedy Entry Tool 
a.  

• Click on the first measure 
and position the insertion 
bar on the two-note chord. 
Remove it by pressing k. 

• Move the insertion bar back to the middle C note again. While 
holding down d, press the 6 key on the number row, not 

on the numeric keypad. When you press d, you tell 
PrintMusic you want to insert a note or rest just before the 
insertion bar. You pressed the 6 key to add a half rest—6 is 
the keyboard equivalent of the half note value. (If you had 
held down a key on your MIDI keyboard while you pressed 
d-6, you would have inserted a note instead of a rest.) 
Again, to insert a note or rest, you must use the number keys 
located on the number row (or above the QWERTY keyboard), 
not on the numeric keypad.

Your example should now 
look like this:

The problem is that there 
are five beats in the mea-
sure —the half rest and 
three quarter notes (even 
though you might not see 
the third note). With PrintMusic’s rhythmic-watchdog feature 
(Jump to Next Measure) turned off, PrintMusic won’t notify 
you until you exit the editing frame.

• Press the 0 (zero) key to exit the editing frame. PrintMusic 
displays a dialog box that tells you that there are too many 
beats in the measure.
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You’re offered four methods of solving the problem. You could 
leave the extra beats in the measure (by selecting the top 
option). You could tell PrintMusic to eliminate any extra beats 
by removing them from the end of the measure (by clicking 
the second radio button). You could tell PrintMusic to insert 
any extra notes that it removes from the end of this measure 
into the beginning of the following measure (by clicking the 
third radio button).

Finally, you could tell PrintMusic to rebar the music by redis-
tributing notes throughout the staff until no measure contains 
more beats than are allowed by the time signature.

• Click “Delete the extra notes,” and then click OK. PrintMusic 
eliminates the extra beat—the last E quarter note—and you 
exit the editing frame.

In the next section, you’ll create a lead sheet that begins with 
a pickup. To complete the first measure’s transformation into 
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the pickup measure, the only task remaining is to create a 
dotted rhythm.

• Press the 0 (zero) key. You reenter the measure.

• Position the insertion bar on the C and press the period (.) 
key. PrintMusic adds a dot to the note. If you were to continue 
typing periods, you could add several dots to a note or rest.

• Press the right arrow key, and then press the 4 key. You’ve 
turned the last quarter note into an eighth note; the pickup 
measure is complete.

ENTERING MUSIC: SPEEDY ENTRY

You’ve now learned the basics of using the Speedy Entry Tool 
with the MIDI keyboard. You’ve learned how to enter notes rap-
idly, change their values, change their pitches, add rests, insert 
notes, add dots, and move around the score using the right and 
left bracket keys.

The measure you’ve been working on now contains the pickup 
notes for “Oh, Susannah.” Using your knowledge of the Speedy 
Entry Tool, enter the next twelve measures as shown. For the 
moment, however, don’t enter any music past measure 13. 
Remember the Speedy Entry keyboard commands you’ve learned:

Key Effect

. (period) Add a dot

4 Eighth note

5 Quarter note

6 Half note
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When you reach measure 14, you may realize that the last four 
bars of “Oh, Susannah” are exactly the same as measures 6 
through 9. To save time, you can use the Selection Tool’s copying 
function to complete the melody.

In the first tutorial, you copied a measure of “Simple Gifts” by drag-
ging one measure so that its image was superimposed on another. In 
some cases, however, you won’t be able to drag measures to copy 
them, because the dragging technique only works when you can see 
both source and target measures on the screen at the same time.

Now you’ll use two PrintMusic shortcuts that can be used to copy 
any amount of music from one place to another, even when the 
source and the target are hundreds of measures apart.

] (right 
bracket)

Go to next measure

[ (left bracket) Go to previous measure

k Remove a note, rest, or 
chord
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SELECTING SEVERAL MEASURES BY SHIFT-CLICK-
ING

It turns out that there’s a common technique for selecting large 
amounts of material—in word processors, spreadsheets, and 
even music programs. It’s called d-clicking. You can use this 
technique to select the four measures you want to copy. It works 
like this:

• Click the Selection Tool  then click measure 6. 

• While pressing d, click measure 9. Measures 6 through 9 
are now selected. 

COPYING MUSIC TO OFF-SCREEN TARGETS

Now you have to copy this music to the end of the piece. Here’s 
another keyboard shortcut. This one, used for copying music 
from one place to another in PrintMusic, works like this:

You’ve already selected the source measures, so proceed as fol-
lows:

• While pressing !, click measure 14 (Mac: b, click mea-
sure 14). That’s a very useful trick to remember: !-click-

Click here . . . Scroll to the endpoint . . . and Shift-click here.

Everything between is selected.

Select the source
measures...

...and Ctrl-Shift (Mac: Option-Shift)
click the first of the target measures.Scroll...

This music... ...gets copied here.
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ing (b-clicking) the target measure is the same as dragging 
the image of the source measures onto the target measures.

A dialog box appears, asking how many times you want the 
material copied. Once (the default) is enough.

• Click OK (or press j). That’s all there is to it! You’ve 
entered all the music for your first lead sheet.

DELETING MEASURES

This version of “Oh, Susannah” is seventeen measures long. How-
ever, you will remember that PrintMusic provided you with 
thirty-one empty measures when you began this tutorial. There-
fore, you now need to delete measures 18 through 31, using the 
Selection Tool.

• Click the Selection Tool . Now adjust your view so that 
measure 18 is visible.

• Click measure 18. Scroll to the end of the piece.d-click on 
the last measure.PrintMusic automatically highlights the mea-
sures you specified, even though you might not be able to see 
the end of the highlighted region.

• From the Edit Menu, select Delete Measure Stack. PrintMusic 
deletes the extraneous measures.

No doubt you created the lead sheet melody with grace and 
aplomb. Nonetheless, there may be times when you need to 
erase some of your music. Here’s the quick way to do it. To 
return to the first measure of the piece, you could use the 
scroll bars. Instead, try this command:

• From the View Menu, choose Home Position. This command 
returns you to the top of the page.
51



Tutorial 1b: Speedy Entry

ERASING MUSIC

• Click the Selection Tool . Or, any tool that allows regional 
selection.

• Select the first two measures of the song. You can use any of 
the selection methods you’ve tried so far: clicking one measure 
and then d-clicking the second, or drag-enclosing both 
at once.

• Press $ (Mac: o). The measures are now empty.

For the purposes of this tutorial, however, you really didn’t 
want to erase the first two measures of the song. Fortunately, 
you can always recover from any Selection Tool action like 
this one, as follows:

• From the Edit Menu, choose Undo. PrintMusic restores the 
music.

MORE ON SPEEDY ENTRY

Combining the speed of Speedy Entry with the convenience of 
Selection Tool copying, as you’ve just done, is a quick, accurate 
method of entering music—especially with practice.

Eventually you’ll discover even more shortcuts: for example, to 
enter several repeated notes, just hold the MIDI keyboard key 
down continuously while you repeatedly press the rhythmic-
value keys (you don’t have to restrike the MIDI keyboard key 
each time). 

As mentioned earlier, you can do the opposite, too. You can tell 
PrintMusic that all the notes you’re about to play are sixteenth 
notes, and then simply play them, as slowly as you wish, on your 
MIDI instrument; PrintMusic will enter them into the score. You 
can press Caps Lock to activate this feature. For instructions, see 
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the User Manual under SPEEDY ENTRY—TO ENTER MANY NOTES 
OF THE SAME VALUE.

Music only gets entered when you press a rhythmic-value key, so 
feel free to play your MIDI keyboard as much as you like, without 
fear that you’ll inadvertently throw notes onto the screen. Chords 
are a breeze, too: just hold down MIDI keyboard keys for the 
notes in the chord before you press the rhythmic-value key.

You can drag any note of a chord up or down to change its pitch, 
just as you did with a single note earlier in the tutorial. If you 
double-click and, on the second click, hold the button down, you 
can drag an entire chord up and down the staff (instead of drag-
ging one note at a time). And don’t forget that you can also drag 
any note or chord horizontally. If you want to drag a note only 
vertically or only horizontally, press d while you drag—
your cursor will be “constrained” to perfectly vertical or horizon-
tal movements.

Take another look at the Speedy Entry Keyboard Commands dia-
grams that appear earlier in this tutorial, and you’ll learn about 
some other features of Speedy Entry. For example, if you position 
the insertion bar on the second of two notes that are beamed 
together, pressing the slash key (/) will break the beam; pressing 
it again will rejoin the beam. There’s also a key that turns any 
note into a grace note (and back again)—the semicolon (;). 

Pressing the t key (lower case letter t) ties a note to the next note. 
!-equal (Mac: b-equal) ties a note to the previous note. 
You can tie all notes of a chord at once by positioning the cross-
bar on the chord stem, and not on any notehead. And, if you’re 
working on a score with several staves, pressing d-down 

arrow (Mac: i) moves the editing frame down to the next 

lower staff; pressing d-up arrow (Mac: d-i) 
moves it back up.
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Finally, if you ever want to hide an entry (a note or rest), just 
position the insertion bar on it and press the letter h key; the 
entry appears lightly in the score and will not print. Also, when 
you begin working with PrintMusic’s four transparent staff layers 
(called Layer 1 through 4), you can flip through the layers by 
pressing d -’ (apostrophe) (Mac: d-down arrow or 

d-up arrow).

There’s no need to 
learn all of these 
key commands 
now. But it might 
be useful for you to keep the Speedy Entry Keyboard Commands 
diagram handy.

PLAYBACK

You’re about to discover that your folk song masterpiece, “Oh, 
Susannah,” not only looks good—it sounds good, too.

It doesn’t matter which tool is currently selected.

• From the Window Menu, choose Playback Controls (if they’re 
not already on the screen). The Playback Controls appear. On 
Windows, the Playback Controls are docked at the top of the 
screen.

On the Macintosh, the Playback Controls are a floating palette, 
shown below:

• Click the Play button 1. If your MIDI system is hooked up 
properly, you’ll hear PrintMusic play the song. To stop play-
back, click either Pause 0 or Stop 8.

If you ever add too many augmentation 
dots, press the appropriate number key to 
return the note to the original duration.
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If you don’t hear anything, 
consult SETTING UP YOUR 
MIDI SYSTEM in the INSTAL-
LATION CHAPTERS earlier in 
this manual.

• On Mac, hide the Playback Controls by clicking on the Win-
dow Menu, then select Playback Controls so that the check 
mark disappears. This step is not required on Windows.

As you’re about to find out, you don’t have to use the Play-
back Controls to play back your score:

• Windows Users: While 
pressing the spacebar, click 
any measure. Mac users: 
hold down Shift, press the 
Space bar and click any 
measure. Once again, Print-
Music plays back your score, this time beginning with the 
measure you clicked. Click anywhere on the screen to pause. 
Of course, this is only the tip of the playback iceberg. Try this 
fun—but useful—feature:

• While pressing ! (Mac: b) and the Space bar, drag 
the cursor back and forth across the notes in the score. This 
“scrubbing” playback feature lets you spot-check any part of 
the score—a useful feature when, for example, you’re entering 
lyrics and want to confirm your place in the music.

You can play any PrintMusic document using either this 
“Space bar-click” method or the Playback Controls. 

More playback features will be discussed in chapter 6: PLAY-
BACK.

If you wish to use the internal 
speaker on a Macintosh, select 
the MIDI Menu, then Internal 
Speaker Playback.

Mac users: when the Playback 
Controls are visible, simply 
pressing the spacebar will 
start playback.
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SETTING THE INITIAL TEMPO

PrintMusic offers a number of ways to set the tempo for a piece. 
For example, in Tutorial 6 you’ll learn how to make tempo mark-
ings such as Allegro, Presto, and ritard actually control the play-
back tempo. For now, though, we’ll set the tempo the quick way.

• Once again, from the Window Menu, choose Playback Con-
trols. The Playback Controls reappear.

• Double-click the Tempo text box, and type 200. You can also 
click the small up and down arrow buttons to increase or 
decrease the number in the Tempo text box. If you want the 
tempo to be measured in half notes per minute—or any other 
rhythmic unit—choose the value you want from the Tempo 
drop-down list.

• Click the Play button. PrintMusic plays your song back at a 
more sprightly tempo.

• When you’re through listening, click on the File Menu and 
choose Save. It’s always a good idea to save your work at the 
end of a session. If you wish, open the file “Tutorial 1b” and 
compare your results to our version.

WHEN YOU’RE READY TO CONTINUE

If you’ve had enough for one session, choose Exit (Mac: Quit) from 
the File Menu. If you want to continue to the next tutorial, close 
the file, saving changes if you wish.

The next tutorial will introduce you to the HyperScribe method of 
entry where PrintMusic will notate as you play in real time.
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FOR MORE INFORMATION

Some of the entries in the User Manual contain discussions of 
topics you’ve just covered. See, for example:

ACCIDENTALS ERASING

CHORDS MEASURES

COPYING MUSIC PLAYBACK

DOTTED NOTES SPEEDY ENTRY
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So far, you’ve explored ways of entering music into PrintMusic 
note-by-note. Simple Entry is useful for working without a MIDI 
keyboard, and Speedy Entry makes good use of the MIDI key-
board with the computer keyboard for extra speed.

One of PrintMusic’s most useful features, however, is its ability 
to record and transcribe a live performance in real time. To do 
this you’ll be using the HyperScribe Tool, which notates your per-
formance almost as fast as you can play it. By the end of this 
tutorial, you should be able to get notes on the page by playing on 
your MIDI keyboard, a method PrintMusic calls HyperScribe.

If you don’t have a MIDI keyboard or microphone, skip ahead to 
Tutorial 2.

INTRODUCTION TO HYPERSCRIBE

Each time you play a note on your MIDI keyboard, the computer 
receives certain information via the MIDI cable: which key you 
struck, how hard you hit it, and how long you held it down. But 
to convert your performance to standard notation, the computer 
needs to know how each note’s duration relates to the beat and 
the measure.

To address this issue, PrintMusic produces a metronome click 
while you play.

HyperScribe, by the way, isn’t just for keyboard virtuosos. No 
matter how slowly you go, HyperScribe is still an excellent means 
of entering music—single-line or simple music in particular—
into a score. Even non-keyboardists often come to prefer Hyper-
Scribe for quick, accurate note entry. With the MicNotator fea-
ture, you can even play your favorite instrument, like clarinet or 
saxophone, to enter notes. See MICNOTATOR in the User Manual 
for more details.

In the following sections, you’ll give HyperScribe a try. For a 
more complete discussion of various settings and how you might 
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use them, see the User Manual under HYPERSCRIBE TOOL or the 
QUANTIZATION GUIDE in the Appendix.

CREATING A NEW DEFAULT DOCUMENT

There are hundreds of variables in published music notation: 
thickness of the staff lines, size of the notes, distance between 
accidentals in a key signature, and so on. PrintMusic will let you 
change settings for some of these variable

However, you probably won’t want to set up your favorite design 
rules each time you create a new piece. Teaching PrintMusic pre-
cisely how you like your music to look could take you half an 
hour every time you launched the program.

The good news is that PrintMusic lets you determine all these 
variables once, after which it remembers your preferences for any 
future piece.  In the PrintMusic 2008/Component Files folder 
there’s a document called Maestro Font Default. This is 
nothing more than a blank PrintMusic document that’s 
been customized with a dummy name, page numbers at the 
bottom of the page, specific music spacing rules, and so on. 
As long as you keep this document in the same folder as the 
PrintMusic program itself, those parameters will always be 
preset when you start PrintMusic or create a new docu-
ment. Of course, you can and should create your own 
default document, using your own favorite setup; the one 
we’ve provided is meant to serve as an example. When you’re 
finished with these tutorials, simply create a new document 
(or modify the one we’ve provided), and make sure you’ve 
named it Maestro Font Default (on Windows, choose .FTM 
for the file type). 

• From the File Menu, choose New, then Default Document. 
PrintMusic presents an untitled document. Remember that its 
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format is determined by the Maestro Font Default document 
in the PrintMusic/Component Files folder.

• From the View Menu, choose Zoom, then select Zoom to 75%. 
Now we need to make sure the settings are correct for our 
experiment.

TRANSCRIBING A SCALE (WITH A CLICK)

• Click the HyperScribe Tool 
g. A new menu appears on 
the menu bar called Hyper-
Scribe, where you’ll make 
your transcription settings.

• From the HyperScribe Menu, 
choose Recording Tempo and Click. In the Recording Tempo 
and Click dialog box, you specify a start signal, set a tempo 
for recording by default (shown on the Playback Controls). 
In the Tempo box, enter the desired tempo. If you are fairly 
proficient at the keyboard, you might want to try a tempo of 
96. Beginner keyboardists might prefer a tempo closer to 60 
for the following example. Your default setting for Beat should 
be a quarter.

• Click OK. That’s it! PrintMusic is now ready to provide you 
with a metronome click. 

If you wish to use the 
internal speaker on a 
Macintosh, select the MIDI 
Menu, then Internal Speaker 
Playback.
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• From the HyperScribe Menu, choose Record Mode. Make sure 

Record into One Staff is selected.

• Click the first measure. A dotted frame surrounds the mea-
sure you clicked, indicating that PrintMusic is ready for you 
to begin. It doesn’t matter whether you play staccato or legato 
(short or connected notes); HyperScribe expands any note you 
play to the beginning of the next note (or beat), so that you 
won’t find scattered sixteenth rests cluttering your music 
when you’re finished. PrintMusic is waiting for you to send a 
signal that you’re ready. Because we set the Start Signal to 
Any MIDI Data, it doesn’t matter which key or pedal you hit.

• Play a note on the keyboard. PrintMusic begins to click, giving 
you two measures countoff to get a feel for the tempo. If you 
don’t get a click, you may wish to review the section called 
SETTING UP YOUR MIDI SYSTEM in the INSTALLATION 
CHAPTERS earlier in this book. You may also wish to consult 
the User Manual under MIDI SETUP DIALOG BOX.

• When the two countoff measures are up, play a two-octave C 
scale, in quarter notes, starting on middle C, as shown below. 

As you play each measure, it fills up with notehead-like dots; 
only when you’ve completely filled a measure (and moved on 
to the next) does the full-fledged notation appear.

• When you’re finished, click your mouse anywhere on the 
screen. The editing frame goes away. Take a look at what 
PrintMusic did: did you get your C scale? If you didn’t, try 
entering a slower tempo in the Recording tempo and Click 
dialog box. Now let’s try a real melody instead of a scale. 
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Tutorial 1c: HyperScribe

TRANSCRIBING A MELODY 

• From the MIDI Menu, choose Quantization Settings. The 
Quantization Settings dialog box appears.

• Under Smallest Note Value, click the eighth note. PrintMusic’s 
sense of rhythm is much finer than ours; in fact, it perceives 
subdivisions of rhythm down to 1024ths of a quarter note. 
(These very small rhythmic increments are called ENIGMA 
Durational Units, or EDUs.) Because PrintMusic’s perception 
of time is so precise, the program must round off, or quantize, 
each note in your performance to the nearest eighth note (or 
whatever rhythmic value you specify), in order to produce 
readable notation. The following example has eighth notes in 
it, so we selected the Eighth Note button under Smallest Note 
Value.

• Click OK. You return to the score. You’ll try a slightly more 
ambitious HyperScribe experiment this time — “Ode to Joy.”

• Click the HyperScribe Tool g and click the first measure. 
You don’t need to erase your C scale; a new HyperScribe pass 
overwrites whatever was there before.

• Play “Ode to Joy” as shown here. 

• When you’re finished, click the mouse. Scroll back to the first 
measure. Look over your piece and see how you did. Feel free 
to try it again; anything new you record will simply overwrite 
whatever music is there now. 
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Tutorial 1c: HyperScribe

SETTING THE TIME SIGNATURE AND BEAMING 
PATTERNS

In the previous experiments, you used PrintMusic’s default 
setting of quarter-note key taps. In the next experiment 
you’ll be trying a piece in L  time, which will require you to 
change some of HyperScribe’s settings.

• Click the Time Signature Tool d. 

• Double-click the first measure. The Time Signature dia-
log box appears.

• Using the upper scroll bar, click the left scroll bar arrow 
once. We have just specified there are three quarter 
notes per measure, which puts our piece in L  time.

• Select Measure 1 through End of Piece (if it’s not already 
selected). 

• Click OK. 

TWO-HANDED HYPERSCRIBING

• From the File Menu, Choose New, and then Document 
with Setup Wizard. For this example, we’ll need to start 
a new default document with a grand staff.

• Click Next, and then on page 2, choose Keyboards in the 
left column, and then double-click Piano so it appears in 
the right column. 

• Click Next, Next, and then Finish to open the new docu-
ment.

• Click the HyperScribe Tool g. The HyperScribe Menu 
appears.
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Tutorial 1c: HyperScribe

• From the HyperScribe Menu, choose Recording Tempo 

and Click. Since you’re playing a L piece, you have to tell 
PrintMusic that each click should equal a quarter note.

• Click the quarter note icon. You’d click the same button 
for a piece in M or J meter.

• Click OK. 

• From the MIDI Menu, select Quantization Settings. The 
Quantization Settings dialog box appears.

• Under Smallest Note Value, click the eighth note. Print-
Music’s sense of rhythm is much finer than ours; in fact, 
it perceives subdivisions of rhythm down to 1024ths of a 
quarter note. (These very small rhythmic increments are 
called ENIGMA Durational Units, or EDUs.) Because 
PrintMusic’s perception of time is so precise, the pro-
gram must round off, or quantize, each note in your per-
formance to the nearest eighth note (or whatever 
rhythmic value you specify), in order to produce read-
able notation.

• Click OK. You’ve told PrintMusic that each click repre-
sents a quarter note, and you’ve specified a quantization 
value. One other parameter has changed since your first 
HyperScribe efforts: You’re using two staves now. 
HyperScribe can split your performance onto two staves 
(to be played by right and left hands), but it needs you 
to specify a split point—a key on the MIDI keyboard, 
below which all notes will be transcribed onto the lower 
staff; the note you play and all higher notes will be 
placed on the upper staff.
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Tutorial 1c: HyperScribe

• From the HyperScribe 

Menu, choose Record 
Mode, then Split into 
Two Staves. Now, 
choose the point 
between the two staves 
you want notes to split 
between the left and right hand staves. If you’re familiar 
with MIDI key numbers (middle C = 60), you can type a 
key number into the text box in the Fixed Split Point 
dialog box that appears. It’s easier, however, to define a 
split point simply by playing the key.

• Click Listen. PrintMusic asks you to play the key you 
want to use as a split point.

• Play the B just below middle C. PrintMusic enters the 
key number into the text box. Now, notes played on or 
above the B below middle C will be placed into the top 
staff.

• Click OK. At this point, you’re ready to go. 

• Click the first measure of the upper staff. After the two 
countoff measures, play this excerpt from Bach’s Minuet 
in G Major. 

• When you’re finished, click the mouse. Scroll back to 
the first measure. If all went well, you should have a 
fairly clean, correctly beamed transcription.
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Tutorial 1c: HyperScribe

• Play back your performance (click Play 1 on the Play-

back Controls). PrintMusic plays back your transcrip-
tion complete with your dynamics and rhythmic feel.

FOR MORE INFORMATION

Some of the entries in the User Manual contain discussions of 
topics you’ve just covered. See, for example:

BEAMING PLAYBACK

TIME SIGNATURES QUANTIZATION

CLEFS HYPERSCRIBE TOOL

MICNOTATOR
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Tutorial 2: Adding Details

There’s a lot more to music than just notes. In this tutorial, we’ll 
cover how to add details—key and time signatures, lyrics, 
repeats, chords, and more. Open the Document called “Tutorial 
2” in the Tutorials folder: We’ll use this version of “Oh, Susan-
nah” to explore PrintMusic’s prowess in creating a lead sheet. By 
the end of this tutorial, you should be able to create a simple lead 
sheet.

CHANGING THE KEY

If you use the Setup Wizard, you should start off with the correct 
key signature for your piece every time. But let’s say you change 
your mind after entering in the music. We’ll change the key for 
our folk song “Oh Susannah.”

• Click the Key Signature Tool h. 

• Double-click the first measure (within the staff lines to the 
right of the time signature). The measure highlights and a dia-
log box appears. PrintMusic displays a dialog box when it’s 
requesting some information from you. In this particular dia-
log box, you use the scroll bar to select a new key. Click the 
up arrow to add sharps to the key signature or subtract flats. 
Click the down arrow to add flats or subtract sharps.
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Tutorial 2: Adding Details
• Click the up arrow on the scroll bar twice, so that no sharps 
or flats appears. Now look at the bottom of the dialog box: 
PrintMusic lets you specify whether or not you want to trans-
pose the notes when you change the key signature. Leave the 
settings as they are; you’re transposing the song up a whole 
step, to C.

Now specify what region of measures you want to be affected 
by the new key. 

• Click the radio button for “Measure 1 Through End of Piece.” 

• Click OK (or press j). The dialog box goes away, and your 
piece is instantly transposed to the key of C.
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CHANGING THE TIME SIGNATURE

If you use the Setup Wizard, you should start off with the correct 
time signature, too. But let’s say you decide your folk song would 
work better in cut time.

• Click the Time Signature Tool d, and double-click the first 
measure. Make sure you click the middle of the measure 
(within the staff lines). There are two scroll bars in the Time 
Signature dialog box: the upper bar controls the top number 
of the time signature, and the bottom bar controls the bottom 
number.

• On the upper scroll bar, click the left scroll bar arrow twice, 
to change the upper number from 4 to 2. You want the meter 
to be J  two half notes per measure—so you decrease the 
upper number, which governs beats per measure.

• Now click the right scroll bar arrow twice on the lower scroll 
bar. The lower scroll bar sets the rhythmic pulse—the lower 
number in the time signature. You increase the value from a 
quarter note to a half note (by changing the lower number 
from 4 to 2). 
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• Click the radio button for “Measure 1 Through End of Piece.” 

The Time Signature dialog box looks like this:

• Click OK (or press j). That’s it. You’ve now put “Oh, Sus-
annah” into cut time. (PrintMusic defaults to displaying the 
cut time symbol C for J . If you’d prefer J , see the User Manual 
under CUT TIME.

ENTERING LYRICS: TYPE INTO SCORE 

One of PrintMusic’s greatest powers is its ability to handle lyrics 
intelligently. If you provide the lyrics, complete with hyphens 
between syllables, PrintMusic can automatically distribute them 
to the melody line, neatly avoiding tied-over notes and rests, and 
centering every syllable under its note. Each syllable is attached 
to its note; if the note moves horizontally, the syllable moves with 
it. PrintMusic also adds word extension underlines for melis-
matic passages automatically.

You can type the lyrics directly into the score, so that you know 
at all times where you are in the music—a feature called Type 
Into Score. 
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Tutorial 2: Adding Details

In this tutorial, you’ll learn how to type lyrics into the score.

• Click the Lyrics Tool k. A new menu, called Lyrics, appears 
and a row of two positioning triangles appears to the left of 
the staff.

• From the Lyrics Menu, choose Type Into Score, if it’s not 
already selected. 

• Click on the staff above the first melody note. You don’t have 
to click the notehead. Instead, click anywhere within the staff 
lines above it. A small blinking cursor—the insertion point—
appears beneath the first note.

• Type: “Oh, I come from Al-a-ba-ma, with a ban-jo on my 
knee.” Each time you type a space or a hyphen, PrintMusic 
automatically moves the insertion point to the next note in 
preparation for entering the next syllable. PrintMusic auto-
matically scrolls the music as you enter the lyrics, so you 
always know where you are.

As you type, there are a few things you should know. If you 
make a mistake, just backspace over it by pressing the $ 
key (Mac: k). (If you backspace to the previous syllable, 
PrintMusic highlights the whole syllable for you, so that you 
can replace it all at once with anything you type.) If you want 
to change a word you’ve already typed, click in the staff above 
the syllable in question so that it’s highlighted; then type in 
your correction.
As you type the rest of these lyrics, you’ll encounter some syl-
lables that are supposed to be held through two melody notes:

In such cases, just skip past the sustained note by pressing 
the space bar. PrintMusic will create word extensions for you 
when appropriate. Use the space bar to skip past rests. 
73



Tutorial 2: Adding Details

• Finish typing the first verse: 

I’m [space] goin’ to Lou’-si-a-na, my [space] true love for to see. 
[space] 
Oh, Su-san-nah, now don’t you cry for me,
Oh, I come from Al-a-ba-ma with a ban-jo on my knee.

The two small triangles at the left edge of the screen control 
the baseline of the lyrics (the imaginary line upon which the 
bottom edges of the words sit). If you drag the triangle, you’ll 
find that you can move the baseline (and all the attached lyr-
ics) up and down.

ADDING A SECOND VERSE

As it happens, “Oh, Susannah” has two verses. If you don’t work 
with lyrics much, feel free to skip this section. If you plan to be 
working with vocal music, though, this section will show you 
how to add multiple verses.

• Click the first note of the piece. The first syllable “Oh,” 
should be highlighted.

• Press the down arrow. A cursor appears below the first sylla-
ble. You are now ready to type in verse 2. You can continue to 
add up to six verses this way. You can use the up and down 
arrow keys to move between verses.

THE REPEAT TOOL

To be truly complete, your lead sheet needs a first and second 
ending, requiring the use of the Repeat Tool x.

In PrintMusic, a repeat barline is simply a signpost that directs 
the flow of music playback back to another measure. 

A repeat barline doesn’t necessarily direct music backward; it 
could make the music jump to a later measure, as it does if you’re 
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Tutorial 2: Adding Details

using a coda sign. You can build nested repeats, multiple end-
ings—even purely graphic repeat barlines that have no playback 
functions at all.

In your “Oh, Susannah” lead sheet, you’ll actually need several 
repeat barlines—one at the beginning of the score, plus a first 
and second ending. To make these endings work properly, you 
need to amend the beginnings and endings of the music itself, 
adjusting the lyrics and inserting the first ending measure, so 
that the lead sheet looks like this:

We have provided a document called “Tutorial 2a,” in which 
these changes have already been made. Open this document 
now.In either case, scroll back to the beginning of the piece; now 
you’re ready to proceed.

The repeat tool is designed to allow you to add standard repeat 
barlines and endings easily using context menus. By context-
clicking (Windows users right-click, Macintosh b-click) mea-
sures and selected regions, you can easily and edit repeats with-
out taking focus off the score. Now, let’s add a repeat with a first 
and second ending.

• Click the Repeat Tool x. Measure 1 is a pickup measure, so 
you want the first repeat barline to appear at the beginning of 
measure 2.

• Windows users Right-click (Macintosh users c-click) mea-
sure 2. A context menu appears which offers several repeat 
options.
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• Choose Create For-

ward Repeat Bar. A 
forward repeat bar 
appears at the begin-
ning of measure 2. 
Note that you could 
also click measure 2 
and from the Repeat Menu choose Create Forward Repeat Bar 
to perform the same task.

Now, let’s create the first and second ending. You want the 
first ending to appear at measure 17. Scroll down so measure 
17 is visible.

• Windows users Right-click (Macintosh users c-click) mea-
sure 17. For a first ending longer than one measure, you 
would select the measure region and then context-click.

• Choose Create First and Second Ending. PrintMusic places a 
first ending over the highlighted measure and also places a 
second ending over the following measure. That’s it! This 
repeat is already defined to play as shown, upon reaching the 
backward repeat bar, playback will jump back to measure 2, 
and then, the second time through, skip over measure 17 to 
the second ending.  

To remove a repeat barline or bracket, click the Repeat Tool, 
then click the measure. Click the square handle at the bottom 
of the barline and press k. Don’t be concerned if your lead 
sheet ends with a single measure stretched over an entire staff 
system. Such layout issues will be discussed in Tutorial 4. 
Finally, please note that PrintMusic also offers a number of 
text repeats, such as D.S. al Coda. These text repeats are 
purely graphic, so they do not affect the playback of your 
score.
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CHORD SYMBOLS (OPTIONAL SECTION)

No true lead sheet would be complete 
without chord symbols. With a little 
help from your MIDI keyboard, the 
process of adding chords can be 
extremely quick. You can also apply 
similar techniques with the Type into 
Score feature, which doesn’t require a 
keyboard. (If most of your work 
won’t require chord symbols, you can skip this section.)

This section assumes that you’ve completed the “Oh, Susannah” 
lead sheet up through the last section. If not, choose Open from 
the File Menu; open the document called “Tutorial 2b,” which is 
complete to this point.

• Scroll to the first measure of the piece, if necessary. 

• Click the Chord Tool X. The Chord Menu appears. The top 
two commands in the menu are chord input options: Type 
Into Score (functions in the same way as the corresponding 
Lyric option); and MIDI Input (which has you play the chord 
on the MIDI keyboard).

• From the Chord Menu, choose MIDI Input. If you don’t have a 
MIDI keyboard, don’t despair; it’s almost as easy to put chord 
symbols into your score without MIDI. See the User Manual 
under CHORD SYMBOLS for instructions.

• Click the first note of the second measure. A little ear appears 
above the staff. It indicates that PrintMusic is ready for you to 
play the chord.

To enter chord symbols 
without a MIDI 
keyboard, click on the 
Chord Tool, then choose 
Type into Score from the 
Chord Menu.
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• Play a C triad, root position, on the MIDI keyboard. It doesn’t 

matter how the chord is voiced or what octave it’s in; just 
make sure that the bottom note is a C.

PrintMusic puts the chord symbol, C, above the staff. (If the 
chord symbols appear too low or too high in your score, 
remember that, just like lyrics, you can drag the leftmost posi-
tioning triangle up or down to move the baseline of the chords.)
So far, so good—now you need to advance the cursor to the 
right, in preparation to enter the next chord symbol. To signal 
PrintMusic that you want to move on to the next chord, you 
play any MIDI keyboard key above middle C. 

• Play a single note—any note—above middle C. If you want to 
move backward, play a single note below middle C.

• Play three more single notes above middle C. You’ve just 
moved the ear cursor to the next downbeat, where there’s 
another chord.
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• Play another C chord, this time in first 

inversion (E on the bottom).  

This time, PrintMusic writes C/E—a C 
triad with an E in the bass.

• Continue adding the chords this way: advance to the next spot 
by playing a single key above middle C, and then play the chord. 
If you don’t play the chord in root position, PrintMusic notates 
the chord symbol as a triad over a bass note, separated by a 
slash. You can add any chord symbols you want; one example is 
shown here:
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Tutorial 2: Adding Details
You’ll find that PrintMusic has no problem transcribing the 
G7 in measure 5. You can play seventh chords, ninths, aug-
mented, diminished, and even more complex chords, and 
PrintMusic will have no problem understanding you.
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If you make a mistake, choose Undo from the Edit Menu, click 
the note, and play the chord again. Here’s how you tell Print-
Music that you’re finished entering chords:

• Click any blank part of the screen. Go ahead—play it back! 
(Click Play 1 on the Playback Controls.) You’ll discover that 
PrintMusic plays the chord symbols wherever they occur. 
(You can also disable the playback function of chords, if you 
like; see the User Manual under CHORD SYMBOLS.)

Now suppose you’re just about ready to print, when you find 
out that this “Oh, Susannah” is going to be a piece of popular 
sheet music, with guitar fretboard diagrams above the staff. 
No problem:

• From the Chord Menu, choose Show Fretboards. PrintMusic 
instantly places full-blown fretboard diagrams underneath 
the regular chord symbols. They’ll even transpose if you 
change the key!

To adjust the distance between the fretboard diagrams and 
the staff, choose Position Fretboards from the Chord Menu, 
and drag the leftmost triangle up or down. See the User Man-
ual under FRETBOARD DIAGRAMS for full instructions.

WORKING WITH INNER VOICES: LAYERS

In this example, let’s suppose that you’ve decided to add a few 
harmony notes.

PrintMusic lets you have up to four voices—independent lines of 
music, each with its own stem—per staff. Most of the time, you’ll 
probably need only two voices, stems up and stems down. You’ll 
find such music especially easy to notate in PrintMusic, because 
every staff can have four completely independent layers of music. 
You can think of them as clear plastic overlays, because each 
layer is utterly independent—each can even have its own MIDI 
channel for playback. You can flip easily from one layer to the 
other, and even hide the ones you’re not working on.
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• For Windows, click the Layer 2 push button in the lower left 

corner of the screen. For Macintosh, choose Layer 2 from the 
pop-up menu in the lower left corner of the screen. You’ve just 
made Layer 2 the active layer of every staff. 

• Click the Simple Entry Tool 4. 

• Click the half note icon 6 in the Simple Entry palette (or 
press 6 on the numeric keypad) to select a half note duration. 

• Position your cursor on the A 
below middle C on the first beat 
of measure 10 and click. Do the 
same for the second half note in 
measure 10. You can see that the 
stems are properly flipped. (Note 
you could also enter these notes 
with the Simple Entry Caret with 
the same results).

• Press @-d-1 (Mac: a-
b-1) to return to Layer 1. The editing frame now displays 
Layer 1, and Layer 2 is dimmed. @-d-# (1-4) (Mac: 
a-b-# (1-4) is a keyboard shortcut used to change the 
active layer while entering.

There is a special case you should be aware of when working 
with layers. There are times, often found in keyboard music, 
when the second voice doesn’t begin until the middle of a mea-
sure (below right). The solution is to fill up the beginning part 
of the measure with rests (below left):

To create the appearance of a Layer 2 voice that begins in mid-
measure (right), first create “placeholder” rests (left). Use the 
letter h key to hide the rests.

While using the Simple 
Entry Caret, when you 
switch layers, 
PrintMusic creates 
placeholder rests for you 
automatically, so you 
can continue entering in 
a new layer at any point 
in the measure.
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In Simple Entry, !/b-click each rest and press the let-
ter h key. The rest dims to indicate it is hidden (and will not 
print); now it’s merely a placeholder to align the notes of the 
second voice. (Press the h key again to make the entry reap-
pear.)

WHEN YOU’RE READY TO CONTINUE

This tutorial has covered a lot of ground; if you’ve made it to the 
end, congratulations. PrintMusic offers a lot of power, and you can 
harness it! Choose Save from the File Menu, if you haven’t already 
done so. If you think you’ve done enough for one session, choose 
Exit (Mac: Quit) from the File Menu, and you’ll return to the desk-
top.

If you want to go on, close this document and turn to the next 
tutorial.

FOR MORE INFORMATION

Some of the entries in the User Manual contain discussions of 
topics you’ve just covered. See, for example:

CHORD SYMBOLS LYRICS
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Tutorial 3: Articulations & Expressions

Now that you know the basics of entering music quickly and edit-
ing it efficiently, it’s time to learn how to add the markings that 
make music such a rich language—articulations, dynamics, 
slurs, and more. Open the document called “Tutorial 3” in the 
Tutorials folder: We’ll use this arrangement of “Oh, Susannah” to 
explore PrintMusic’s fluency in the language of music. By the end 
of this tutorial, you should be able to create a score with all the 
necessary markings.

BASIC ARTICULATIONS AND EXPRESSIONS

We’ll start with an introduction to articulations (staccatos, 
accents, fermatas) and expressions (Moderato, F , solo).

• Click the Articulation Tool 
t. Using this tool, you 
can click on, above, or 
below a note—it doesn’t 
matter. PrintMusic’s artic-
ulations are smart; they 
jump into place, centered on the notehead, automatically.

You must be in the same layer as 
your notes to attach anything to 
them, such as lyrics, 
articulations, expressions, or 
chord symbols.
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• Click the dotted quarter note in the Trombone 2 staff in mea-

sure 3. The Articulation Selection dialog box appears.

Incidentally, some symbols, such as <, have been defined to 
flip upside-down automatically when a note’s stem direction 
changes (as a result of a transposition, for example). Articula-
tions with an associated upside-down symbol appear side-by-
side in their selection square.

• Double-click the accent mark (top row, third from left). Dou-
ble-clicking an Articulation in this dialog box is the same as 
clicking once then clicking Select.

When you return to the score, you can see that PrintMusic not 
only centered the accent on the notehead, but it also knew 
which side of the note (top or bottom) to use. You can over-
ride PrintMusic’s placement decision, of course—to move the 
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mark, drag its handle. (You can also delete a mark by clicking 
its handle and pressing k.)

So that you understand what’s happening behind the scenes, 
try this experiment:

• Click the Simple Entry Tool 5. Windows users !-click, 

Mac users  b-click squarely on the notehead of the dotted 
quarter note; press the down arrow three times until the stem 
direction changes. PrintMusic doesn’t simply flip the stem—it 
also relocates the accent mark to the other side of the note. 
Press the up arrow three times to move it back into place.

Now let’s add a couple dynamic markings.

• Click the Expression Tool y.  For 
the moment, let’s put in a F mark-
ing.

To add an expression 
while entering with the 
caret in Simple Entry, 
press the X key.
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• Position the cursor below the first note of the top staff, just to 

the left of the note. Double-click where you want the marking 
to appear. The Expression Selection dialog box appears.

• Double-click on F. The F marking is now in this staff If you 
want to adjust its position, drag its handle. (To delete any 
expression, click its handle and press k.)

ADDING A SLUR

As a quick exercise, let’s add some slurs to the score.

• Click the Smart Shape Tool W. The Smart Shape Palette 
appears as a toolbar on the top of the screen (or as a palette on 
the Macintosh), containing icons for slurs, crescendos, 8va 
markings, lines, and several kinds of brackets and lines. This 
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palette is just like the others you’ve encountered; you can hide 
it or move it around.

The curves and lines this palette offers are called Smart 
Shapes, because they behave intelligently; if the measure wid-
ens, so does the Smart Shape attached to it. If a Smart Shape 
begins at the end of one line of music and continues onto the 
next, it automatically breaks in two.

The Slur Tool W should already be selected; if not, select it 
now.

• Place your cursor on the first note in measure five (top staff).  

• Double-click the mouse, hold the button down after the sec-
ond click, and drag the mouse to the right, until the third note 
in the measure is highlighted. As long as you hold the button 
down, you can move the endpoint of the slur.

• Release the mouse button. 
You’ve just created a note-
attached slur. Take a 
look. Is the slur exactly 
where you wanted it? 
Does it arc too high or too 
low?

A Smart Shape is easy to edit. When a Smart Shape has multi-
ple handles, it’s currently selected. Each slur will have six 
handles. Here is a description of how to use these handles to 
edit the slur:

Shortcuts for the Smart Shape 
Tool: Hold down S for a slur, < 
for a crescendo or > for a 
decrescendo.
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Hold down the d key while editing the slur to “con-
strain” your cursor to perfect horizontal or vertical move-
ments. 

• Position the cursor at the top of the arc. Click and drag down-
ward to decrease the arc of the slur. Now create another slur. 
Scroll to the beginning of measure 3.

• Position the cursor on the first note in measure 3 (top staff). 
Double-click and drag to the last note in the measure. Release 
the mouse button. The new phrase marking displays its 
reshaping handles, letting you know that it’s selected. The 
first one you drew, meanwhile, is no longer selected. Instead, 
it displays a single handle. To select a Smart Shape that 
doesn’t display its reshaping handles, click its handle.

Feel free to experiment with these Smart Shapes. Click and 
drag each reshaping handle to see what it does. Try adding a 
crescendo or decrescendo.

When the Smart Shape Tool is selected, every Smart Shape in 
the score displays a small square handle on the screen (unless 
it’s already been selected, in which case it has reshaping han-
dles). To delete a Smart Shape, click the handle to select the 
shape—and press the k key. For more information, see 
the User Manual under SMART SHAPE TOOL.

Drag this handle to 
move the left end-
point.

Drag this handle to 
move the right end-
point.

Drag this handle to 
move the entire shape.

Drag this handle to 
change the arc.

Drag this handle to move 
the arc asymmetrically.

Drag this handle to 
move the arc asym-
metrically.
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Before moving on, you can choose to hide the Smart Shape 
Palette by deselecting it in the Window Menu. Otherwise, feel 
free to leave it on the screen.

SELECTION TOOL

If you’re flying along in the editing process and don’t want to 
bother switching tools, the Selection Tool can help speed you 
along. Click on the Selection Tool and click on any marking. Now 
you can move it, delete it, or right-click (Mac: c-click) on it 
for a list of other editing commands. If you decide you need to do 
advanced editing, double-click on the marking to switch to the 
appropriate editing tool. You can return to the Selection Tool at 
any time by clicking c-d-A (Mac: a-d-A).

The Selection Tool works on Measures (Measure Tool), Notes 
(Simple Entry), Smart Shapes, Expressions, Articulations, 
Repeats, Lyrics, Chords, Text Blocks, Tuplets, Time Signatures, 
Key Signatures, Clefs,  and Staff Names. For more details, see the 
User Manual under SELECTION TOOL.

PUTTING IN MANY ARTICULATIONS

Let’s learn some more about articulations.

The system you learned earlier for putting in articulations is fine 
for the occasional accent or staccato marking. But what if you 
have a series of accented eighth notes? Do you have to go through 
the Articulation Selection dialog box for every single note? Fortu-
nately, no. You can select a region of notes and tell PrintMusic to 
apply the same symbol to every one.

• With the Articulation Tool selected, drag across the remain-
ing note stems of measure 2. A bold black box will show you 
which notes you’ve drag-selected. When you release the mouse 
button, the Articulation Selection dialog box appears.
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• Double-click the staccato mark. You return to the score; the 

remaining notes now have staccato marks.

• Drag a box over the first two articu-
lation handles. You can now drag or 
nudge both of these articulations 
simultaneously.

• Hold down the  key and click or drag over additional articula-
tions. This way, you can pick and choose the articulations 
you want to position or edit. 

THE “NUDGE” KEYS (ARROW KEYS)

• Click the Expression Tool y.

• Click the F mark’s handle and press the left arrow key. The 

F marking moves just a pixel (screen dot) to the left. You 

may have to look very closely to see it move at all. You can 
continue to reposition any marking whose handle is selected 
by pressing the up, down, left, and right arrows. 

MARKINGS THAT PLAY BACK

Now that you’ve put a few staccatos and dynamics in your score, 
try this: While pressing the Space bar, click the first measure (the 
shortcut for a quick playback). You’ll notice that your staccatos 
and breathmarks actually affect the articulation of the notes in 
playback!

You’ll soon discover that all of 
the dynamic markings (in the 
Expression Tool) and some of 
the Articulations have been 
defined for playback; as soon 

Use c-Z (Mac: 
a-Z) as a shortcut 
for Undo.

Mac users: when the Playback 
Controls are visible, simply 
pressing the spacebar will start 
playback.
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as you place them into your score, they affect the playback in a 
musical way.

Remember you can also define playback tempo on any Expres-
sion.

WHEN YOU’RE READY TO CONTINUE

Choose Save from the File Menu if you haven’t already done so. If 
you think you’ve done enough for one session, choose Exit (Mac: 
Quit) from the File Menu, and you’ll return to the desktop.

If you want to go on, close this document and turn to the next 
tutorial.

FOR MORE INFORMATION

Some of the entries in the User Manual contain discussions of 
topics you’ve just covered. See, for example:

METATOOLS STACCATO MARKS
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Although Finale automatically updates the score layout as you 
enter music, any measure, staff, system, or page can be resized, 
dragged or nudged as you see fit. Once you learn a few basic Selec-
tion Tool and Page Layout procedures, you’ll see how easy it is to 
ensure a beautiful and precise layout for any score.

To prepare for this lesson, open the document called “Tutorial 4,” 
which consists of a barbershop arrangement of “Auld Lang Syne.”

MEASURE LAYOUT

For this example, we’ll distribute measures to 4 per line.

• From the Utilities Menu, choose Fit Measures. The Fit Measures 
dialog box appears.

• Make sure “Lock Layout with _ Measure(s) per System” is 
selected as well as “whole document.” 

• 4 should be selected already. If not, enter 4 after “Lock Layout 
with...”
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• Click OK. Finale re-assigns your music so 4 measures appear on 

each system. A fourth system is added at the bottom of the page 
to accommodate this arrangement. 
You can also select a region of measures and group them in a 
system using the “Lock Selected Measures Into One System” 
command in the Fit Measures dialog box.

When we set four measures per system, Finale added an addi-
tional system on the next page to accommodate the final mea-
sure. Next, let’s move this orphan measure back to the first 
page.

• Click the next page arrow at the 
bottom of the screen to advance 
to page 2. Notice the single-mea-
sure system at the top of the page. 

• Click anywhere in the system to select the measure. The system 
is highlighted.

• Press the up arrow. Finale moves this measure to the previous 
system on the first page. Similarly, you can click the last measure 
of a system and press the down arrow to move it to the next sys-
tem. Try it now. Press n to remove selection and then click 
measure 7. Press the down arrow to move it to the next system 
and then press the up arrow to move it back.
With any of the Fit Measures commands, the layout depends 
on your good judgment. Remember, PrintMusic automatically 
lays out your music with as many measures as it can fit on a 
line; you’re free to override its placement decisions, but the 
result may be measures that are too wide or too crowded.

By locking a specific number of measures on a system you’ve 
created measure groups, PrintMusic’s system of locking mea-
sures within a system (hence the non-printing lock icon ç). 
Be aware that once a measure has been manipulated in this 
way, the measures are locked into this arrangement, and they 
won’t be affected by future measure-rearranging commands 
like Update Layout or Begin a New Staff System. You can 
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remove locked measure groups from the piece by choosing 
Update Layout from the Edit Menu while pressing d.

PICKUP MEASURES

Let’s turn the first measure of “Auld Lang Syne” into a proper 
pickup measure. There are several ways to do this, but we’ll show 
you the easiest. This method changes the first measure in the docu-
ment into a pickup measure. 

• From the Document Menu, choose Pickup Measure. The Pickup 
Measure dialog box opens, where you can tell PrintMusic how 
long your pickup lasts. Click the note that corresponds to the 
sum of the pickup notes. In our example, we have a quarter note.

• Click the quarter note, then click OK. PrintMusic hides the half 
note rest and the quarter note rest and only displays our pickup 
notes. PrintMusic even fixes the measure numbers to automati-
cally skip the pickup measure. You may have noticed that the 
notes are still spaced as though the half note rest were still there. 
Never fear, we’ll fix the spacing in the next section.

SPACING THE MUSIC

As noted earlier in Tutorial 1, Print-
Music is automatically applying 
professional publisher-standard 
note spacing to your music as you 
go along. (This feature can be 
turned off by deselecting Automatic 
Music Spacing from the Edit Menu.) 
Automatic Music Spacing not only spaces the notes, it is designed 
to avoid the collision of chords, lyrics, and other score elements. In 
most cases, you will never need to worry about this feature. How-
ever, you may encounter instances when the music does not 
appear to be spaced correctly; usually, the automatic spacing 

Pressing !/a-4 
when measures are 
highlighted with the 
Selection Tool is a shortcut 
to Apply Note Spacing.
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hasn’t been triggered yet. Here, then, are the steps to follow to per-
form music spacing (it has not yet been performed in this score so 
you can see the effects):

• Click the Selection Tool . 
• Click just to the left of the top staff, in any staff system. This is a 

quick way to select an entire staff with one click. You’ll notice 
that the whole line is highlighted. Because we don’t want to over-
look the bass staff while making spacing decisions, we’ll need to 
select the bass staff, too.

• Hold down the d key and click just to the left of the bass 
staff, in any staff system. Now both staves should be highlighted 
through the entire piece.

• From the Utilities Menu, choose 
Apply Music Spacing. When 
PrintMusic’s finished, you might 
notice that the spacing of music 
and barlines is much more profes-
sional looking. Every measure is 
exactly as wide as it needs to be, 
and every note is allotted exactly the right amount of horizontal 
space. Music spaced in this way is said to have nonlinear spac-
ing, as in published music: A whole note doesn’t get as much hor-
izontal space as four quarter notes—it actually gets much less. 
For more information about PrintMusic’s three music spacing 
types, see the User Manual under MUSIC SPACING.
There is one more critical behind-the-scenes function in 
action here: Update Layout. Again, PrintMusic is configured 
to perform this function automatically (it can be disabled by 
deselecting Automatic Update Layout from the Edit menu).

When you use the Music Spacing command, you correct the 
spacing of the notes, lyrics, and accidentals of your piece; 
PrintMusic still must calculate the effects of your respacing 
on the layout of the measures. If you ever notice that mea-

Use Time Signature 
Spacing in the Utilities 
Menu, Music Spacing 
submenu, to restore default 
spacing.
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sures seem too wide or too narrow, select Update Layout from 
the Edit Menu, or press !-U (Mac: a-backslash).

THE PAGE LAYOUT TOOL

The units of measurement PrintMusic normally uses are inches. 
You can work in whatever units you feel most comfortable with.

From the Edit Menu, choose Measurement Units; from the 
submenu, choose Inches (if it’s not already selected). 

• Click the Page Layout Tool f. 
Your page of sheet music is 
instantly covered with a series of 
horizontal and vertical lines with 
handles attached. Although this 
may appear confusing at first, the function of the handles will 
become clear as we examine the page in depth.

To view your entire 
page, click on the View 
Menu, select Zoom, then 
Fit in Window.
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The handles (and their associated lines) control two distinct 
sets of margins: Page margins, which allow you to determine 
how much of the page (from side to side and from top to bot-
tom) you will use for the music; and staff system margins, 
which allow you to indent staff systems, increase the space 
allotted to systems, and so on. A staff system, or system for 
short, is one line of music, no matter how many instruments 
(staves) are in it.

As you've no doubt already guessed, the lines that run to the 
edges of the page are the currently defined page margins. The 
rectangles that enclose the three systems of music are the staff 
system margins. Each system has two handles, one at the 

Page margins

Top and 

left system 

margins

System

System 

Bottom and 

right system 

margins

Lock icons

Numbers
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upper left corner and one at the lower right corner. To manip-
ulate any margin, simply drag its handle. You can even drag-
enclose margin handles or select all margin handles with 
c-A (Mac: a-A). To move the entire system, creating 
more space between systems for a choreographer’s note or a 
title, simply click on the system and drag it into place.

The page currently appears based on Finale’s default layout 
settings. You might decide there is some extra space above the 
top system, we’ll move the music higher on the page. 

• Click the top left 
handle of the first 
system and drag 
down about an inch, 
as shown: 
Notice you can also 
drag this handle 
left or right to adjust the horizontal position of the left system 
margin. Once you’ve selected the handle you can also use the 
down arrow to nudge the system margin with more precision.

The spacing on the page remains the same, but now there is 
room to move the system up (before colliding with the top 
page margin). When you do, subsequent systems will reposi-
tion uniformly.

For precise positioning, from the Page 
Layout Menu, choose Systems and then 
Edit Margins. Here, you can specify 
spacing numerically. You will notice the 
values here change as you drag system 
margin handles.
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• Click anywhere in the top system and 

drag up and to the right. Keep drag-
ging as far up and to the right as pos-
sible. You are only able to move the 
system until it lies against the right 
and top page margins. Notice all the 
systems on the page moved up accordingly.
PrintMusic can also automatically space the systems evenly 
down the page with the Space Systems Evenly command. To 
space the systems, PrintMusic adjusts the Distance Between 
Systems, without changing the system margins. Because we 
want to make sure our title doesn’t get covered up when we 
space the systems later, we’ll make the top system margin big-
ger to include the title.

• From the Page Layout Menu, choose Space Systems Evenly. In 
the Space Systems Evenly dialog box, you can tell PrintMusic 
which pages to space and when to skip pages (such as pages only 
two systems full). The default settings are fine, so just click OK.
Voila! All of your systems are spaced evenly between the top 
and bottom margins of the page.

THE RESIZE TOOL

You’ve already experimented with the Zoom command in the View 
Menu. This command—and the options on its submenu—allow 
you to “zoom in” to and “zoom out” from your document, magnify-
ing or reducing your view of it. During the entire process, however, 
the actual size of the music—the printed image—remains precisely 
the same.

The Resize Tool, however, can resize the music itself. 

For this example, use the document called “Tutorial 4” that you’ve 
been working on to this point and scroll to page 1.

c-click (Mac: 
a-click) and drag 
to move systems 
independently.
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• Click the Resize Tool w. The amount of music to be resized 

depends on where you click on the screen.
• Press the Home key. Or, scroll to the top left of the page. 
• Click to the left of the top staff. The Resize Staff dialog box 

appears, asking how much to resize the staff.

• Type 80 and click OK. You’ve just created a cue (or rehearsal) 
staff at 80% of the normal staff size.

• Click the upper-left corner of the 
page. The Resize Page dialog box 
appears.

To resize a system using 
Resize Staff System, you 
must have more than one 
staff; otherwise, use 
Resize Staff.
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• Type 75. Click OK.

NOTE: If you use the Resize Tool on a system or a page, as 
you’ve just done, you change the measure widths. When-
ever you perform any operation in PrintMusic that 
changes the measure widths, you must tell PrintMusic to 
compensate by rearranging the layout of measures. As 
noted previously, PrintMusic performs an Automatic 
Update Layout for you; if you have decided to turn this 
feature off, you'll need to do it manually now.

THE TEXT TOOL

The Text Tool is used to enter text onto a single page or multiple 
pages. Titles, subtitles, composer credits, page numbers, copyright 
notices, and dates are good examples.

For best results, don’t use the Text Tool for musical text like Ada-
gio and rehearsal letters. Use the Expression Tool for these pur-
poses (see Tutorial 3).

If you create a document using the Document Setup Wizard, you 
will be prompted for a title. For this tutorial document, we have 
provided you with a dummy title, “Title.” The word “Title” has 
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brackets around it, to tell you it’s special, a text insert. We’ll talk 
more about text inserts later in this tutorial.

Now, you’ll add a subtitle to “Auld Lang Syne.”

• Press the Home key on your computer keyboard. In Page View, 
Home Position shifts the view to the upper-left corner of the page 
you’re working on. (In Scroll View, it returns you to measure 1.)

• Click the Text Tool [. The Text Menu appears, and the title, 
“Auld Lang Syne,” sprouts a small square handle.

• Double-click the title’s handle. An editing frame appears around 
the text, and a blinking cursor appears within the frame. “Auld 
Lang Syne” is enclosed in a gray box which indicates this is a 
“Text Insert.” In other words, this text is defined elsewhere so it 
can be replicated easily. This would be the case if this score were 
created with the Setup Wizard. 

• From the File Menu, choose File Info. If you wanted to change 
the Title Text (or the Composer or Copyright), you would do it 
here. 

• Enter “Times Gone By” in the Subtitle text box. 
• Click OK. The File Info dialog box disappears and the blinking 

cursor is still to the left of our title.
• Press the right arrow key h. The cursor moves to the right of 

the title text insert.
• Press Return. The cursor moves to the next line. Now set the font 

size.
• From the Text Menu, choose Size, and then choose the desired 

font size. For a subtitle, a 10- or 12-point size should work well. 
You can also set the typeface by selecting the text and choosing a 
typeface from the Font dialog box or submenu of the Text Menu. 

• From the Text Menu, choose Inserts, then Subtitle. “Times Gone 
By” appears beneath the title. If you want to change the typeface, 
highlight the new text and choose a new typeface from the Font 
submenu of the Text Menu. (The title is in Arial 18-point bold). If 
you want to change the size or style (e.g., bold) of the text, you 
can make your selection from the appropriate submenu of the 
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Text Menu. Now, change the justification so the subtitle is cen-
tered beneath the title.

• From the Text Menu, choose Justification and then Center. The 
commands in this submenu allow you to specify how you want 
your text aligned in the text box.

• Select Center Horizontally. PrintMusic has centered your subtitle 
on the page. You can also manually adjust the position of any 
text block by dragging its handle.

(If the text block shows an editing frame, click anywhere on 
the page to see its handle.) You might want to adjust the verti-
cal position of your subtitle. To delete a text block, click its 
handle and press k.

In addition to entering 
titles and special 
instructions to players, 
the Text Tool can also 
be used to place page 
numbers into your 
score, as well as the document name, current date, and cur-
rent time (important features if you plan to update and 
reprint your score at some future time). PrintMusic provides 
several useful keyboard shortcuts for many of these features; 
let’s explore some of them here.  

• Double-click in the bottom right corner of the page. An editing 
frame appears.

• Type “Page”, type a space, then press !(Mac: a)-

d-P. This keyboard shortcut instructs PrintMusic to place a 
page number insert at the current cursor position. (You could 

Note that page numbers are already 
assigned (starting on page 2) when you
start a new score using the Setup 
Wizard or a template.
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also select Page Number from the Inserts submenu of the Text 
Menu.) The number 1 appears, surrounded by a box. The box 
indicates that this number is not ordinary text, but a dynamic 
insert, meaning that if you created this insert on the second page 
of your score, it would display the number 2 instead of the num-
ber 1. See TEXT TOOL in the User Manual for a further discus-
sion of inserts.

• Press !(Mac: a)-d-] (right bracket). This key-
board shortcut instructs PrintMusic to align the text block with 
the right margin of the page. (You could also select Right from 
the Placement submenu of the Text Menu.) You have now suc-
cessfully entered a page number for your score. We can quickly 
instruct PrintMusic to display your page number on every subse-
quent page, without having to manually enter a different page 
number every time.

PRINTING BASICS

There are essentially two kinds of printers that work with Print-
Music: PostScript-equipped printers, suitable for professional pub-
lishing; and non-PostScript printers, including inkjet and 
bubblejet printers.

PrintMusic’s output truly shines when you print on a PostScript 
printer. PostScript is a page-description language spoken by com-
puters and printers, just as MIDI is a language spoken by comput-
ers and MIDI keyboards. (If you want truly typeset-quality 
printing, you can take your PrintMusic files on a disk to an output 
shop—something like a copy shop/graphics service bereau—and 
have it printed on a Linotronic imagesetter, a very expensive Post-
Script machine that creates published-quality printouts.)

Just as A, B, and C are characters in a standard text font, notes 
and musical symbols are characters in PrintMusic’s music font, 
called Maestro. Maestro, and the other fonts that come with Print-
Music, is provided as a Postscript and TrueType font.
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All text and musical symbols should look outstanding at any size. 
However, when you print at reduced sizes, a non-PostScript 
printer produces unevenly spaced staff lines, slightly 
“stairstepped” eighth-note beams, or somewhat jagged slurs 
(because these lines and shapes are actually graphics and not font 
items).

• From the File Menu, choose Print and click OK in the dialog box 
that appears. In a moment, your printer should begin to print 
your score.

WHEN YOU’RE READY TO CONTINUE

You’ve learned some very important concepts in this tutorial. In 
fact, these techniques and principles constitute much of the editing 
work you’ll need to do in PrintMusic. Here’s a quick review of what 
you’ve covered, in order:

1. Use the Selection Edit Tool to arrange measures.
2. Use the Music Spacing command to space and align notes, 

avoid collisions of lyrics and accidentals, and set ideal 
measure widths. 

3. Especially after using the Music Spacing command, it’s 
important to choose Update Layout from the Edit Menu, so 
you can see what the final layout will be. You should get in 
the habit of updating the layout just before printing—so 
that you never get unexpected results when you print.

4. Use the Page Layout Tool to adjust the spacing of all sys-
tems on the page.

5. Use the Text Tool to add titles, composer credits, copyright 
notices, and so on.

If you’ve had enough for this session, choose Exit (Mac: Quit) from 
the File Menu. If you want to go on, close the document you have 
open.
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FOR MORE INFORMATION

Some of the entries in the User Manual contain discussions of top-
ics you’ve just covered. See, for example:

PAGE LAYOUT PRINTING

SELECTION TOOL SYSTEMS

MEASURE LAYOUT TEXT INSERTS

TITLES RESIZE
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Tutorial 5: Working with Scores

It’s time to learn about PrintMusic’s more powerful score-ori-
ented features. If you plan to work mainly on lead sheets, you 
may just want to skim this section. But if you intend to create 
multi-staff scores—particularly orchestral scores—you will want 
to go through this whole tutorial. By the end of this tutorial, you 
should be able to create from scratch a conductor’s score and 
parts.

If you have a document currently open, close it.

• Open the document called “Tutorial 5.” This document cur-
rently consists of a single staff, filled with music.

• From the View Menu, select Scroll View. You may find that it is 
easier to do all of your editing work in Scroll View (where the 
music is laid out in a continuous horizontal band), especially 
when working with scores that contain several staves.

• Click the Staff Tool s.

• From the Staff Menu, choose New Staves. The Staff Setup 
Wizard appears asking you what staves you would like to 
add.

• Click on Strings in the left column, then double-click Violin, 
then Viola, then Cello. The three instruments appear in the 
right-hand column.

• Click Finish. PrintMusic has added 
three evenly spaced staves, giving 
you a total of four; let’s imagine 
that you’re going to create a string 
quartet.

You can reposition a staff by grab-
bing its handle and dragging it up or down. To remove a staff, 
click it and then press k.

To see more staves, 
select a smaller view 
percentage from the 
View Menu, Zoom 
submenu.
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SETTING CLEFS AND STAFF NAMES

If you use the Setup Wizard, you’ll have all of the clefs and staff 
names set up for you. If you decide you don’t like what the Wiz-
ard chose, you can always edit them using the techniques below. 
We’ll edit the new staves to match the appropriate clefs and 
names for a string quartet.

• Click the top staff. When you click anywhere on the staff to the 
right of the time signature, you select the staff. You can also use 
the Staff Tool to select measures, such as for applying Alternate 
Notation. 

• From the Staff 
Menu, select Edit 
Staff Attributes. 
The Staff 
Attributes dialog 
box appears. (You 
can also double-
click the staff.)

The full name of 
the instrument will 
appear next to the 
staff in the first 
system (line) of the 
piece. The abbrevi-
ated name will appear next to subsequent systems.

• Click in the text box called Full Name and type “Violin I”. 

• Click in the text box called Abbr. Name and type “Vln. I”. 

Incidentally, you establish the default font for staff names 
using the Select Default Fonts command in the Options menu 
(this will affect all staff names for newly created staves; it will 
not change existing staff names).
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You could click OK at this point; you’d return to the score, 
where the first staff’s name would now appear. However, as 
long as you’re at it, you may as well set up the other staves:

• From the staff drop-down list at the top of the Staff Attributes 
dialog box, choose Violin[Staff 2]. The contents of the dialog 
box change to reflect the staff attributes of the second staff in 
the score.

• Rename this staff Violin II, and enter Vln. II as its abbreviated 
name, then click OK. 

• Double-click the bracket handle. A small box at either end of 
the bracket. The bracket attributes dialog box appears.

• Click where it says “Violin II” in the Staff drop-down list. 
Select Violin I to include the Violin I staff in the bracket.

• Click OK. Your bracket should now surround the staves of 
your entire string quartet.
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SELECTING PARTIAL MEASURES; TRANSPOSING A 
REGION

Up to this point, you’ve done all your manipulation of music in 
one-measure increments. Using the Selection Tool, you’ve clicked 
a measure to select it, drag-enclosed several whole measures, 
clicked the first measure and d-clicked the last measure, or 
clicked in the left margin to select an entire staff.

But selecting a measure at a time is like selecting a word at a time 
in a word processor—it’s a nice shortcut, but sometimes you 
need to select in smaller units.

What if you want to select half a measure—or only one note?

• Click the Selection Tool . You don’t need to change any set-
tings to select partial measures, just learn a couple tech-
niques.

In the musical example you have on the screen, for example, 
suppose you decide that a certain passage in the Violin I part 
would sound better if it were up a third.

• Scroll to measure 6. Click and hold in measure 6, just above 
and before the third beat. Drag down and to the right, until 
you’ve selected the first two eighth notes in measure 7. When 
you release the mouse button, the region is highlighted. 

• Hold down d and press h once. Notice the selection 

expands one note to the right. 

• Hold down d and press g once. The selection con-
tracts to its original size. When you first select a region, hold 
down d and press g if you want to adjust the begin-

&
b

b

6

œ œ œ œ œ
œ œ# œ œn œ# œ œ

3

œ# œ œ

3

œn œ œ œ
114



Tutorial 5: Working with Scores

ning of the region instead of the end. Hold down d and 

Windows users !, Mac users b, to expand and con-
tract by full measures.

• From the Utilities Menu, choose Transpose. The Transposi-
tion dialog box appears.

• Choose the radio but-
tons for Up and Diatoni-
cally. From the Interval 
drop-down list, choose 
Third. Click OK. You 
return to the score, and 
the selected region is 
now up a third.

If a region including 
partial measures is too big to drag-select (e.g. on different 
pages), drag-select a smaller region that begins where desired, 
navigate so the desired end-point is in view, then hold down 
d and click to specify the end of the selection. If you do 
want to select a whole measure, double-click the measure. (If 
you double-click a second time, and your score has more than 
one staff, you extend the selection vertically, to include the 
selected measures in every staff - also called the “measure 
stack.”)

The technique you just learned—selecting a region, then 
applying a command from the Utilities Menu—is extremely 
powerful. Select some music, and then take a glance at the 
commands in this Menu to the other available options. 

INSERTING STAVES

Let’s say we add a flute to our string quartet. We could use the same 
technique for adding staves as before, but this time we’ll save some 
work and let the Wizard create them.

Use the following key commands to 
quickly transpose a selected region:
!/a-6 = Down M2
!/a-7 = Up M2
!/a-8 = Down octave
!/a-9 = Up Octave
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• Click the Staff Tool s. The Staff Menu appears. We want to 

insert our flute staff above the Violin I staff.

• Click on the handle of the Violin I staff. The staff handle is a 
small box on the top staff line near the clef.

• From the Staff Menu, choose New Staves. The Parts page of 
the Setup Wizard appears. 

• Double-click on the Flute in the middle column. The Flute 
instrument appears in the selection window.

• Click on the Finish button. The Wizard adds a Flute staff 
above our selected staff, in this case the Violin I staff.

TRANSPOSING INSTRUMENTS

But what if we made a mistake? What if we really wanted to add 
a clarinet? You could delete the flute staff and add a clarinet from 
the Wizard, but let’s say you’ve already added music and you 
don’t want to lose it. We’ve already seen how to change the staff 
name earlier in this Tutorial, so we’ll just cover how to change 
the staff from a C instrument to a transposing instrument.

• Click the Staff Tool s. 

• Double-click on the Flute staff to the right of the clef and sig-
natures. The Staff Attributes dialog box for the Flute staff 
appears. Using the techniques you learned earlier, change the 
Staff Names to Clarinet and Cl., but don’t exit the Staff 
Attributes dialog box.

• Next to Transposition, click the down-arrow and select the 
Clarinet transposition: () Up M2, Add 2 sharps. 

• Click OK. Your staff should now look like a clarinet staff, 
complete with transposition. All of the other non-transposing 
staves have two flats in the key signature, while the top staff 
has no flats in a Bf transposition.
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WHEN YOU’RE READY TO CONTINUE

Close your string quartet document, saving it if you want.

In the next tutorial, we’ll cover some techniques for Guitar nota-
tion and tablature. If you won’t be notating for guitar, feel free to 
skip Tutorial 6.

FOR MORE INFORMATION

Some of the entries in the User Manual contain discussions of 
topics you’ve just covered. See, for example:

CLEFS TRANSPOSING INSTRUMENTS

EXTRACTING PARTS TRANSPOSING (BY INTERVAL)
STAFF NAMES STAVES
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PrintMusic offers a variety of features for notation of guitar and 
other fretted instruments. In this chapter you will learn how to 
create a score with tablature, and edit tab staves. If you do not 
plan on notating for guitar (or another fretted instrument), feel 
free to skip ahead to the next chapter.  

CREATING GUITAR TABLATURE 

Let’s start by creating a new document containing both standard 
and tablature notation. We’ll use the Document Setup Wizard to 
do this. 

• Click the File Menu, choose New, then select Document with 
Setup Wizard. You will now see page one of the Setup Wizard. 

• Click Next. Page two of the setup Wizard appears. 

• In the left column, click the Plucked Strings category. A list of 
stringed instruments appears in the second column. 

• In the second column, click Guitar and then click the Add 
button. “Guitar” appears in the third column. 

• In the second column, click Guitar [Tab] and then click the 
Add button. Now, both “Guitar” and “Guitar [Tab]” appear in 
the third column. 

• Type “Guitar with Tab”.

• Click in the Composer box and type your name.

• Click Next. The Wizard asks for the time signature and the 
key signature. We’ll leave these settings alone for now. 

• Click Next. The Wizard asks you to specify a tempo, pickup 
measure and default music font. Again, we can leave these set-
tings alone.

• Click Finish. The document opens with a standard notation 
staff above a tablature staff. You are now ready to begin enter-
ing your music.
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The document you just created is already set up to take into 
account the standard guitar transposition which sounds an 
octave lower than written. Now, let’s learn the best way to enter 
music into a guitar score.

COPYING MUSIC TO AND FROM A TAB STAFF 

There are a few ways to enter into a tab staff. We’ll start with the 
most basic, copying music directly from a standard staff into tab-
lature. To demonstrate this we’ll start with a document that 
already contains music in standard notation.   

• Open the tutorial document called “Tutorial 6.” A score titled 
“Spanish Dance No. 2” appears. The first eight measures con-
tain standard notation, but no tab. Here’s how to create tab 
from existing music in standard notation.

• Click the Selection Tool .  

• Click the first measure so it is highlighted. 

• Hold down the Shift d key and click measure 4. Now 
measures one through four should be highlighted. 

• Drag the highlighted region down to the tab staff, and release 
the mouse button. You should now see the Lowest Fret dialog 
box. We’ll talk more about this dialog box soon.

• Click OK. The first four measures of music will now translate 
into tablature notation. You should now have tab of the mel-
ody line like the example below. 
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In this case, the fret numbers represent the pitch as played on 
the lowest possible fret in standard guitar tuning. 

Now, let’s say you want the tab positioned farther up the 
neck. Here’s how to specify the lowest fret for any music cop-
ied from a regular notation staff into a tab staff. The Selection 
Tool should still be selected.

• Click measure 5 so it is highlighted.

• Hold down the Shift d key and click measure 8. Now 
measures five through eight should be highlighted. 

• Drag the highlighted region down to the tab staff. You should 
now see the Lowest Fret dialog box.

• For Specify Lowest Fret, enter “5”. We’ll say you want to 
place all the numbers on the 5th fret or above.

• Click OK. The tab staff will now have all notes fingered no 
lower than the 5th fret.

This ability to copy music from standard notation into tab, 
and specify a lowest fret, can be applied to smaller areas of 
the score by selecting part of the measure. To do this, click the 
Edit Menu and enable Select Partial Measures.

In addition to translating standard notation directly to tabla-
ture, you can also copy tablature directly into a standard 
notation staff. We will use the second half of “Spanish Dance 
No. 2” to demonstrate this. For this example the tablature is 
entered for you already. 
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• With the Selection Tool selected, click measure 9 of the tab 

staff. 

• Hold down the Shift d key and click measure 16 of the 
tab staff. Now measures nine through sixteen of the tab staff 
should be highlighted. 

• Drag the highlighted region up to the standard staff. Measures 
nine through sixteen translate directly into standard notation. 
You should now have notation of the melody line like the fol-
lowing example (starting with measure 9). 

In addition to changing the lowest fret while copying, you can 
also change the lowest fret for any region of tablature with the 
Selection Tool. To do this, click the Selection Tool and high-
light a region of the tablature staff. Then, from the Utilities 
Menu, choose Utilities >> Change Lowest Fret. Enter the new 
Lowest Fret and click OK to apply your changes and return to 
the score. 

CHANGING THE STRING AND FRET NUMBER 

You can edit tab numbers and move them between strings manu-
ally with the Simple Entry Tool. This method gives more control 
over the movement of single and non-contiguous fingerings. 

If you look at measure five in the tablature staff you’ll see that 
the fourth note is played at the fifth fret of the fourth string. It 
might be easier to finger this passage if that note was fingered at 
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the tenth fret of the fifth string. Simple Entry makes this task 
easy.   

• Click the Simple Entry Tool 4.

• While pressing the ! (Mac: b) key, on the fifth mea-
sure, click the “5” on the fourth string and drag it down to the 
fifth string. You will see that this fingering has moved to the 
new string and fret, and the number has changed accordingly. 
You can also use the up arrow e and down arrow f to 
move selected tab numbers between strings, or the left arrow 
g and right arrow h to move selection between fret numbers 
horizontally.

You can also easily change the fret number. The Simple Entry 
Tool should still be selected.

• While pressing the ! (Mac: b) key click any fret num-
ber in the tab staff. The tab number changes color to indicate 
it is selected. 

• In the Numeric Keypad (or while holding down !-d, 
or on Mac, b-d), type a new number. You can now use 
the numeric keypad (numpad) to enter any one or two digit 
number. 

• Hit the “+” or “-” key to raise or lower the fret number by one. 
Remember that when you change the fret number, you are 
effectively changing its pitch. To ensure the standard notation 
accurately represents the tablature, drag the tablature up to 
the standard notation staff with Selection Tool.  

ENTRY DIRECTLY INTO A TAB STAFF

In addition to copying from a standard notation staff, you can 
also enter tab directly into a tab staff. This comes in handy if you 
are working with a tab staff only or already know the tablature 
and not the standard notation. Again, we’ll continue to use the 
same file we’ve been working on to describe how to do this, first 
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by entering tablature with your mouse, and then with your com-
puter keyboard.

• Click the Selection Tool  and highlight the first two mea-
sures of the tab staff. Measures 1 and 2 of the tab staff should 
be highlighted.

• Press the Backspace $ (Mac: o) key to remove the 
existing tab notation from these first measures. You should 
now see standard notation above an empty tab staff for the 
first two measures. 

• Click the Simple Entry Tool 4. We are now ready to begin 
entering into the tab staff manually. For now, we’ll enter tab 
for the existing notes in the standard notation staff. In the 
future, you could use this procedure to enter into a score con-
taining a tab staff only. 

• Click the Eighth Note Tool 
4 in the Simple Entry Pal-
ette. You will need to 
choose the rhythmic value 
of the entry first so Print-
Music knows its duration, 
and how to properly space 
each fret number. 

• Click the tab staff on the third (G) string directly below the 
first note in the piece. A “0” appears. When you click directly 
into a tab staff, you will always see a “0” first.  

• Press numpad 2 (or while holding down !-d, or on 
Mac, b-d, press 2). The “0” changes to “2”.

Use the up and down arrows to 
move a selected fret number up 
or down a string. The number 
will adjust to reflect the same 
pitch on the new string.
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• Click the tab staff on 

the third string 
directly below the 
second note in the 
piece. A “0” appears 
on the G string.

• Press numpad 3. The second fret number changes to 3. You 
can use this method, first clicking the rhythmic duration, 
clicking the string and then typing the fret number to create 
all of your tab notation, but you can also quickly enter tabla-
ture without the use of the mouse with the Simple Entry 
Caret.

• Press the right arrow h key. The caret is now active on the 
second beat of the first measure.

• On your QWERTY keyboard, 
type 2. Notice the Caret moves 
to the second (B) string. Use 
numbers 1 through 6 on your 
QWERTY keyboard to specify 
the string for the fret number 
you are about to enter. 1 is the 
top string, 6 is the bottom.

• Press numpad 3. PrintMusic places a “3” on the B string and 
the caret moves to the right. (Notebook users, see the tip at 
right.)

• Press numpad 1. PrintMusic places a “1” on the same string. 
Now, lets say we want to add another note below the “1” on 
the second beat. 

• Hold down @ (Mac: b) and type 4 on the QWERTY key-
board. PrintMusic adds a “0” on the fourth sting below the 
fret number you just entered. 

If you do not have a numeric keypad, 
you can press j to add a 0 on the 
caret pitch, then hold down !-
d (Mac b-d) and type 
the number. 
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• Hold down @ (Mac: b) and type num-

pad 3 (or, !-d (Mac: b-d) 3). 
The “0” changes to a “3”. You can use the 
last two steps at any time, first entering the 
string and then the fret number to create 
chords. You can also use the up and down 
arrows to specify the string for an additional 
fret number and then hold down ! 
(Mac: a) and press j) to add a note on the same string 
displayed on the caret. Then hold down @ (Mac: b) and 
type the desired number on the numeric keypad. 

• Press k to remove the 
extra fret number. Now, let’s 
finish the measure.

• On the QWERTY keyboard, 
type 3 to specify the G string, 
then, on the numeric keypad, 
type 3 and then 2. You have completed tab for the first mea-
sure. The Caret should appear at the beginning of measure 2. 
Note that you can always press the left arrow g key to select 
the fret number you just entered, type a new number on the 
number keypad to replace the old, and then press the right 
arrow h key to continue entering.

• Type numpad 3 to enter the 
first fret number in measure 
2. Now, we’ll enter a rest.

• Press l. PrintMusic adds a 
rest ‘on the and’ of beat 1. 
Since rests are generally not 
displayed on tab staves, the rest is hidden. It will display as a 
shaded rest in the score, and will not appear in the printout. 
Now, let’s enter the half note on the second beat.

To see a list of Simple Entry 
keyboard shortcuts from the 
Simple Menu, choose TAB 
Specific Commands.  

Refer back to Tutorial 1a for 
information on entering 
standard notation with the 
Simple Entry Caret.
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• Hold down !, @ and d (Mac: c, a and 

d) and then, on the QWERTY keyboard, type 6. Notice the 
note on the Caret changes to a half note. The next fret number 
is on the same string, so we can just type in the fret number.

• Press Enter. 
PrintMusic places 
a 0 on the string. 
You could have 
instead hit the 0 
key on the 
numeric keypad. 
Measures 1 and 2 
are now complete.

Instead of typing the string and fret number, you can also use 
a MIDI device to enter tablature with the Simple Entry Caret. 
First, from the Simple Menu, ensure Use MIDI Device for 
Input is checked. Then, with the Caret active, choose the 
rhythmic duration (!, @ and d (Mac: c, b 
and d) and the number on the QWERTY keyboard) and 
then play the note. PrintMusic will place the fret number on 
the appropriate string.

There are many additional keystrokes you can use while 
entering tablature using the Simple Entry Caret. For a com-
plete list, from the Simple Menu, choose TAB Specific Com-
mands. 

HINTS AND TIPS FOR TABLATURE

For complete information, see TABLATURE in the User Manual.

• To customize the smallest note value for a HyperScribe ses-
sion, first configure your Quantization Settings. From the 
MIDI menu choose Quantization Settings. For more informa-
tion, see QUANTIZATION in the User Manual. 
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FOR MORE INFORMATION

Some of the entries in the User Manual contain discussions of 
topics you’ve just covered. See, for example:

COPYING MUSIC SMART SHAPE TOOL

HYPERSCRIBE SIMPLE ENTRY
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If you’ve followed the step-by-step procedures to this point, 
you’ve seen most of PrintMusic’s tools at work. You’re not 
expected to remember all this material, of course; you can always 
re-read the in-depth discussions presented in this volume and 
consult the User Manual and QuickStart Video Tips at any time 
(under the Help Menu).

But knowing which tools are at your disposal is only half the 
learning process. Now you need to learn how to maximize the 
program’s speed and power to produce the most music, with the 
fewest false steps, and in the shortest time.

EDITING THE MAESTRO FONT DEFAULT

If there are items that you want to appear on every new docu-
ment, such as a copyright at the bottom of the page, you can edit 
the Maestro Font Default file and save it. Then, each time you 
start a new default document, or begin a new document from the 
Setup Wizard, this item will appear in the score. As mentioned 
earlier, you can also edit any document option and apply it to the 
Maestro Font Default. Here’s how:

• From the File Menu, choose Open. Navigate to the PrintMusic/
Component files folder. On Windows, from the Files of Type 
drop down list, choose *.FTM. 

• Double-click the file Maestro Font Default. A new default file 
opens.

• Make any desired changes. For example, from the Document 
Menu, choose Select Default Fonts to change default fonts for 
various document elements.

• From the File Menu, choose Save. 

• On Windows, from the Files of Type drop-down list, choose 
Fianle Template File. Mac users skip to the next step.
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• Name the file “Maestro Font Default” and click save. You 

replace the old Maestro Font Default with your new one. Now, 
the settings you made apply for new documents.

Note that you will only be able to use this feature if the Maestro 
Font Default file is located in the PrintMusic/Component Files 
folder. If this file is removed from the Component Files folder, 
PrintMusic will open a completely blank unformulated, one mea-
sure score when you choose File > New > New Default Document 
or begin a new score with the Setup Wizard.

ORDER OF ENTRY

In general, you can make the most of your time by creating your 
documents in the following order. Save your work frequently. 
The list below is just one possibility; you may find a different 
order suits your style better.

1. Use the Setup Wizard or a template to define the instruments 
and basic layout of your piece. If needed, add, delete or edit 
staves with the Staff Tool.

2. Enter the music using the Simple Entry Tool, Speedy Entry 
Tool, or HyperScribe. 

3. Edit the music with the Simple Entry Tool. Get familiar with 
the numeric keypad commands, including duration shortcuts 
and keystrokes for selecting other tools. Remember, you can 
right-click (Mac c-click) any entry to edit it with a 
context menu, or !-click (Mac b-click) to select any 
note and use a modifier keystroke to edit the note. To see a 
list of keystrokes, from the Simple Menu, choose Simple Edit 
Commands. 

4. Using the Playback Controls, listen to your piece to check for 
mistakes.

5. Put in the lyrics using Type into Score.
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6. Use the Repeat Tool to place any repeats.

7. Add chord symbols and fretboards.

8. Put in all the expression markings: articulations, dynamics, 
slurs, and so on. 

9. Verify that the music is spaced correctly; if necessary, use the 
Music Spacing commands in the Utilities Menu.

10. Use the Resize Tool to specify the overall size of the music 
(by clicking the upper-left corner of the page).

11. Look the piece over in Page View. Fix bad page turns or sys-
tem breaks, using the Fit Measures command under the Utili-
ties Menu. Use the Selection Tool to move measures up or 
down systems as necessary using the up and down arrows.

12. Add rehearsal notes, subtitles, and page numbers with the 
Text Tool.

13. Use the Page Layout Tool to make final adjustments to your 
score and parts.

SCANNING MUSIC

If you intend to make the most of PrintMusic’s scanning capabili-
ties, note that there are a variety of ways for you to scan sheet 
music and bring the results into PrintMusic. You can bring your 
scanned files into Musitek’s MIDISCAN or SmartScore software, 
then import the resulting files into PrintMusic. Or, you could use 
PrintMusic’s built-in SmartScore technology to translate the 
scanned image. The SmartScore Lite feature in PrintMusic, like 
many music scanning products, doesn’t recognize articulation 
marks, hairpins, double or repeat barlines, or text. It will recog-
nize 3 accidental types, 3 clefs, 16 staves per page, smallest note 
value is a 32nd note, and a maximum of 1 augmentation dot.
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Because scanning is not a perfect science, you will need to clean 
up any file after conversion. Depending on the music, some users 
will find it easier to simply re-enter the music via one of PrintMu-
sic's traditional note entry methods: Simple Entry, Speedy Entry, 
or HyperScribe.

Remember that to take advantage of any of PrintMusic's scanning 
capabilities, you will need to have a properly installed scanner 
(contact the manufacturer of your scanner if you have questions). 
Because scanners and scanning software varies widely, we can-
not provide instructions on how to prepare a file for every scan-
ner. For some hints on how to prepare a scanned file from some 
popular scanners, see SCANNING in the User Manual. The scanned 
sheet music image should be saved as a black and white (or line 
art) graphic in TIFF format at a resolution of 300dpi. 

To open scanned files with SmartScore Lite

• Scan one page at 300 dpi (dots per inch), producing a black 
and white (line art) TIFF file. If black and white (or Line Art) 
is not an option, choose grayscale. 

• In PrintMusic!, click on the File Menu, and choose Scanning: 
SmartScore Lite. The SmartScore Lite dialog box appears.

• Click Add Files to List. The Open dialog appears where you 
can choose the scanned file you want to translate. 

• Navigate to your TIFF file and double-click on it. The file 
name of the file you chose will appear in the file list. 

• Repeat the last two steps to add more files to the list. Or, 
choose several files at once in the Open dialog box if there are 
several files you want to convert.   

• Click Begin Recognition. PrintMusic transcribes the scanned 
file and opens the new file. If you encounter problems, please 
double-check the limitations listed above. See also Scanning 
in the Troubleshooting chapter.

• Save the file with a new name. 
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• Make any desired edits. Because scanning is not a perfect sci-

ence, you will need to proofread the score and correct for 
missing notes, ties or dots.

• Convert slurs to ties, where needed. SmartScore will attempt 
to convert ties based on context (Are the two slurred notes the 
same pitch?) but may occasionally guess incorrectly and 
insert a slur. Although slurs and ties are graphically the same; 
slurs and ties are different musically. Remove the incorrect 
slurs with the Smart Shape Tools. Add the ties with the Sim-
ple or Speedy Entry Tools. For more information, see SCAN-
NING in the User Manual.

LINKS TO THE REST OF THE WORLD

PrintMusic is the most well-connected program you can imagine. 
It can share its music with sequencers, or other notation pro-
grams. With the Finale Showcase, you can even post your files on 
the Finale music website <www.finalemusic.com> and share with 
friends across the globe. 

One of the most useful examples of PrintMusic’s cooperation 
with other software is its ability to handle standard MIDI 
sequencer files. These special files contain MIDI playback data. 
Most sequencer programs (Digital Performer, Sonar, Cubase, and 
so on) can generate and read them, and so can PrintMusic. That 
means that you can create your music in your favorite sequencer; 
when it’s polished and ready to be notated, save it on your disk 
as a MIDI file and open it with PrintMusic; it will turn into stan-
dard notation. When you attempt this process, you’ll discover 
that PrintMusic offers literally dozens of options for separating 
and recombining the music on the various tracks of the sequencer 
file. If you want, PrintMusic will even retain the velocity, rhyth-
mic “feel,” and controller information from the original sequence. 
See MIDI FILES in the User Manual for more details.
133



Making the Most of PrintMusic

Note, too, that PrintMusic can read files created in other music 
notation programs from MakeMusic, including SongWriter, 
Finale, Allegro, Finale Guitar, and NotePad. Files created in ear-
lier versions of any of MakeMusic’s notation programs can be 
opened in PrintMusic directly, even in the opposite platform. For 
example, files created in PrintMusic! 2006 for Windows can be 
opened in PrintMusic for Macintosh. IMPORTANT: None of 
MakeMusic's older products can read PrintMusic files directly. 
To share your files with others who do not own the most recent 
version of PrintMusic, have them download Finale NotePad 2008 
which is available for free at www.finalemusic.com and will open 
any file saved from PrintMusic. 

THE NEXT PRINTMUSIC

Your response to PrintMusic is extremely important to us; the 
version of PrintMusic you’re now using reflects the comments 
and suggestions of thousands of users. Please send us your ideas 
and “wish lists” as you get to know the program. We’ll read and 
consider everything we receive; PrintMusic will continue to 
become better, faster, and easier to use.

In the meantime, you have at your disposal a musical tool of tre-
mendous power and flexibility. You’ve seen some of what Print-
Music can do, and you’ll discover other useful features as you 
become acquainted with it. With this volume and the User Man-
ual as your guides, you should now be ready to work on a project 
of your own. 

A fascinating experience awaits you. Here’s hoping that 
PrintMusic enhances your musical productivity and creativity in 
ways you’ve never imagined possible.
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IMPORTANT—READ THIS AGREEMENT! BY INSTALLING 
FINALE PRINTMUSIC®, YOU AGREE TO BE BOUND BY THIS 
LICENSE AGREEMENT. A COPY OF THIS LICENSE AGREE-
MENT CAN BE FOUND ON WWW.MAKEMUSIC.COM. IF YOU 
DO NOT AGREE TO THE TERMS AND LIMITATIONS OF THIS 
LICENSE AGREEMENT, promptly return the entire FINALE PRINT-
MUSIC® package, to the place where you obtained it to receive a 
refund.
MAKEMUSIC, INC. (“MAKEMUSIC”) is licensing the FINALE 
PRINTMUSIC® software programs contained in this disk packet and 
the FINALE PRINTMUSIC® package (collectively “the SOFT-
WARE”) to you on the following terms and conditions:
1. GRANT OF LICENSE. In consideration of the license fee that is a 
part of the price you paid for this product, MAKEMUSIC grants you, as 
licensee, a nonexclusive right to use the SOFTWARE on one operating 
system (“OS”) on one computer ("CPU") under the terms and limita-
tions of this License Agreement. An OPERATING SYSTEM (OS) is 
defined as a software program that manages the hardware and system 
resources of a computer.
2. OWNERSHIP. As licensee, you own the documentation materials 
and the media on which the SOFTWARE is recorded, but MAKEMU-
SIC retains all ownership and rights in the SOFTWARE, including all 
rights in any portion(s) of the SOFTWARE present in any output of the 
SOFTWARE. This License Agreement is NOT a sale of the SOFT-
WARE.
3. USE RESTRICTIONS. You may physically transfer the SOFT-
WARE from one OS on one CPU to another, provided that the SOFT-
WARE is used on only one OS on one CPU at a time. You may not 
install or use the SOFTWARE on a network, multiple CPU, multiple 
OS, multiple site arrangement, or any other hardware or software con-
figuration where the SOFTWARE is accessible to more than one CPU 
and OS or to more than one user. You may not use telecommunication 
transmissions to electronically transfer the SOFTWARE from one CPU 
to another. To protect MAKEMUSIC’s copyrights and trade secrets in 
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the SOFTWARE, you may not adapt or make alterations to the SOFT-
WARE, decompile, disassemble, translate, convert to another program-
ming language or otherwise reverse engineer the SOFTWARE.
4. TRANSFER RESTRICTIONS. You may not transfer, assign, sell, or 
otherwise dispose of the SOFTWARE on a permanent basis without the 
written permission of MAKEMUSIC. Should MAKEMUSIC grant 
such permission, you may be required to pay a Transfer Fee in effect at 
the time of the transfer. In no event may you rent, lease, grant subli-
censes or any other rights in the SOFTWARE to others on a temporary 
basis, including renting the SOFTWARE and CPU together to other 
users.
5. COPY RESTRICTIONS. You may make one copy of the SOFT-
WARE solely for backup purposes. The backup copy automatically 
becomes the property of MAKEMUSIC and is subject to this License 
Agreement. You must reproduce MAKEMUSIC’s copyright notice on 
the backup copy.
6. AUTHORIZATION. You have 30 days from date of installation of 
the SOFTWARE to authorize each copy of the SOFTWARE. The first 
time you launch the SOFTWARE, you will be prompted to authorize 
the SOFTWARE via the Internet, phone, fax or mail. If you choose not 
to authorize, you will be prompted to do so each time you launch the 
SOFTWARE. If authorization is not completed within thirty days, print-
ing and saving are
disabled until you choose to authorize.
7. SUPPORT AND UPDATE POLICY. MAKEMUSIC is not responsi-
ble for maintaining or helping you to use the SOFTWARE, except 
through MAKEMUSIC’s CUSTOMER SUPPORT SYSTEM. From 
time to time, MAKEMUSIC may update the SOFTWARE. By register-
ing the SOFTWARE with MAKEMUSIC by any of the various meth-
ods permitted, you will be able to use MAKEMUSIC’s CUSTOMER 
SUPPORT SYSTEM. In addition, you will receive information regard-
ing updated versions of the SOFTWARE. Future upgrades will be made 
available to licensees who have registered the SOFTWARE with 
MAKEMUSIC and paid an Upgrade Fee.
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8. TERMINATION. This License Agreement is effective upon installa-
tion of the SOFTWARE and remains in effect until expiration of all 
copyright interests in the SOFTWARE, unless earlier terminated. This 
License Agreement will terminate automatically without notice from 
MAKEMUSIC if you fail to comply with any of the terms or limitations 
of this License Agreement. Upon termination you must return all copies 
of the SOFTWARE to MAKEMUSIC.
8. MISCELLANEOUS. This License Agreement is the complete and 
exclusive agreement between you and MAKEMUSIC relating to the 
SOFTWARE and shall be interpreted under the laws of the State of 
Minnesota applicable to contracts made in Minnesota.
The SOFTWARE and accompanying documentation materials may also 
be protected under federal copyright and patent laws. Unauthorized 
copying or use of the SOFTWARE beyond the scope of this License 
Agreement is expressly forbidden. You may be held legally responsible 
for any copyright or patent infringement that is caused or encouraged by 
your failure to abide by the terms and conditions of this License Agree-
ment.
SOFTWARE DISCLAIMER OF WARRANTY AND LIMITED 
WARRANTY FOR MEDIA
THE SOFTWARE AND ACCOMPANYING DOCUMENTATION 
MATERIALS ARE PROVIDED SOLELY ON AN “AS IS” BASIS, 
WITHOUT WARRANTY OF ANY KIND. THE ENTIRE RISK AS 
TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE 
AND ACCOMPANYING DOCUMENTATION MATERIALS IS 
WITH YOU. YOU ASSUME ALL RESPONSIBILITY FOR SELEC-
TION OF THE SOFTWARE AND ACCOMPANYING DOCUMEN-
TATION MATERIALS TO ACHIEVE YOUR INTENDED 
RESULTS, AND FOR THE INSTALLATION, USE, AND RESULTS 
OF THE SOFTWARE. IF THE SOFTWARE OR ACCOMPANYING 
DOCUMENTATION MATERIALS PROVE TO BE DEFECTIVE, 
YOU, NOT MAKEMUSIC OR ITS DEALERS, DISTRIBUTORS, 
AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF 
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ANY AND ALL NECESSARY SERVICING, REPAIR, OR CORREC-
TION.
MAKEMUSIC warrants to the original licensee of the SOFTWARE 
that the media on which the SOFTWARE and accompanying documen-
tation materials are recorded will be free from defects in materials or 
workmanship under normal use for a period of 90 days from the date of 
purchase of the media and documentation materials as evidenced by a 
receipt. This warranty will be null and void if the media appears to have 
been damaged due to unauthorized service, modification, accident, 
abuse, misuse, or excessive wear.
MAKEMUSIC’s entire liability and your exclusive remedy as to defec-
tive media shall be replacement of the defective media. MAKEMUSIC 
will replace any defective media you return during the 90 day warranty 
period, without charge, provided you have registered the SOFTWARE 
with MAKEMUSIC. Prior to returning the defective media, you must 
call MAKEMUSIC for a return authorization number. Returned media 
should be shipped in a protective package to MAKEMUSIC at the 
address shown in the documentation materials, and should be accompa-
nied by the return authorization number, a copy of the paid receipt, a 
brief description of the problem and your return address. SOME 
STATES DO NOT ALLOW LIMITATION ON HOW LONG AN 
IMPLIED WARRANTY LASTS, SO THE 90 DAY LIMITATION 
MAY NOT APPLY TO YOU.
Neither MAKEMUSIC nor anyone else involved in the creation, pro-
duction, licensing, or delivery of the SOFTWARE and documentation 
materials shall be liable for any indirect, incidental, consequential, or 
special damages (including damages for lost profits or the like) resulting 
from breach of warranty or any type of claim arising from the use or 
inability to use the SOFTWARE, even if MAKEMUSIC has been 
advised of the possibility of such damages. In any event, MAKEMU-
SIC’s responsibility for direct damages is never more than the purchase 
price and license fee you paid for the FINALE PRINTMUSIC® pack-
age. SOME STATES DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAM-
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AGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
EXCEPT AS EXPRESSLY PROVIDED ABOVE, MAKEMUSIC 
INC. MAKES NO WARRANTIES REGARDING THE SOFTWARE, 
DOCUMENTATION MATERIALS, OR MEDIA, EITHER EXPRESS 
OR IMPLIED, INCLUDED BUT NOT LIMITED TO WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. No oral or written information or advice provided by 
MAKEMUSIC, its dealers, distributors, agents, or employees shall cre-
ate any other warranty or increase in any way the scope of this warranty, 
and you may NOT rely on such information or advice. THIS LIMITED 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU 
MAY ALSO HAVE OTHER RIGHTS THAT VARY FROM STATE 
TO STATE.
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